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Microsoft Word 2016 |

Creating a Newsletter
with a Pull-Quote and
Graphics

Objectives
YOL; will have mastefed the material_ in this modul_e when you can:
* Insert and format WordArt * Insert a column break
* Set custom tab stops * Insert and format a text box
= Crop a graphic » Copy and paste using a split window
* Rotate a graphic * Balance columns
* Format a document in multiple columns - Modify and format a SmartArt graphic
* Justify a paragraph - Copy and paste using the Office

Clipboard
» Add an art page border

* Hyphenate a document

* Format a character as a drop cap

Introduction

Professional-looking documents, such as newsletters and brochures, often are created
using desktop publishing software. With desktop publishing software, you can divide a
document in multiple columns, wrap text around diagrams and other graphical images,
change fonts and font sizes, add color and lines, and so on, to create an attention-
grabbing document. Desktop publishing software, such as Microsoft Publisher,

Adobe PageMaker, or QuarkXpress, enables you to open an existing word processing
document and enhance it through formatting tools not provided in your word
processing software. Word, however, provides many of the formatting features that you
would find in a desktop publishing program. Thus, you can use Word to create eye-
catching newsletters and brochures.



Project — Newsletter

A newsletter is a publication geared for a specific audience that is created on
a recurring basis, such as weekly, monthly, or quarterly. The audience may be
subscribers, club members, employees, customers, patrons, students, ctc.

The project in this module uses Word to produce the two-page newsletter
shown in Figure 7 1. The newsletter is a monthly publication called Security Tiends.
Each issue of Security Trends contains a feature article and announcements. This
month’s feature article discusses biometrics. The feature article spans the first two
columns of the first page of the newsletter and then continues on the second page.
The announcements, which are located in the third column of the first page, inform
subscribers about discounts and an upcoming webinar and announce the topic of the
next issue’s feature article.

The Security Trends newsletter in this module incorporates the desktop
publishing features of Word. The body of each page of the newsletter is divided
in three columns. A variety of fonts, font sizes, and colors add visual appeal to the
document. The first page has text wrapped around a pull-quote, and the sccond
page has text wrapped around a graphic. Horizontal and vertical lines separate
distinct areas of the newsletter, including a page border around the perimeter of
each page.

The project in this module involves several steps requiring you to drag and drop.

If you drag to the wrong location, you may want to cancel an action. Remember that

you ahways can click the Undo button on the Quick Access Toolbar or press CTRLAZ to

cancel your most recent action.

In this module, you will learn how to create the newsletter shown in Figure 7- 1.

The following roadmap identifies general activities you will perform as you progress
through this module:

1. CREATE the NAMEPLATE FOR the FIRST PAGE of the newsletter.
FORMAT the FIRST PAGE of the body of the newsletter.

CREATE a PULL-QUOTE on the first page of the newsletter.
CREATE the NAMEPLATE EOR the SECOND PAGE of the newsletter.
FORMAT the SECOND PAGE of the body of the newsletter.

oA

ADD a PAGE BORDER to the newsletter.

Desktop Publishing Terminology

As you create professional-looking newsletters and brochures, you should be
familiar with several desktop publishing terms. Figure 7-1 identifies these terms:
* A nameplate, or banner, is the portion of a newsletter that contains the title of
the newsletter and usually an issue information line.

* The issue information line identifies the specific publication.

* A ruling line, usually identified by its direction as a horizontal rule or vertical
rule, is a line that separates areas of the newsletter.

* A subhead is a heading within the body of the newsletter.

e A pull-quote is text that is pulled, or copied, from the text of the document and
given graphical emphasis.
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lonthly Newsletter

Biometrics

iometric cevices verify a
| persan’s identity by trans-

lating 2 behavioral or
physical personat characteristic,
such asa fingerpiint, Into a digital
codethat is compared with a dig-
ital code stored In a Computer or
mabile device. If the digital code
in the computer or moile device
does not match the personal
chasacteristic code, the computer
or moblle device
denles access 1o
theindividual

Biometic devices
grant  access o

in text box

progiams, mobile” |
devices, comput-
&%, Ot [0GMS sing
computer analysk
of some parsonal
characteristic. For
example, types of
biomeatric devices and systems
consist of fingerpent meaders,
face recognition systems, hand
geometry systems, vok e verifica-
tion systems, signature vesifica-
tion systems, and irks recognition
systemsarretinal scanners.

Fisgerosnt, Ressder

A fingeeprint reader, also called &

prink scanner, caplyres the

curves 2nd indentations of one's
fingesprint. Organizations use
fingesprint readers to secuie
doors, computers, and software.
With the cost of fingerpriat read-
ers often %ess than $100, some
hame #nd small business vsers
purchase fingerprint readess o
verify the identity of ysers before
they can access a computer. The
reader also can be set up to per-
form different func-
tions fou diffesent
fingers; for exam-
ple, one finger runs

B ettt T RS-

Issue 15“/
i

|| issue information

line

oot

Reader Discouniietm———4— subhead |
Enterthe ¥ letter, L !
Security Trends, when shopping
anline or mention sur newsktter

name ta logal stares to receive a
10 peicent discount on regular
priced products at these ratallars:
Broman Electronics, Henderson
Office World, Super Software
Warehouse, and Total Securty
Systems.

Frie Welinas
Are you lnterested In learning
more about blometric soltions

aprogram and 3 gif- for personal use? Joln a webinar
f::::g fingar shuts presented by Melissa Roberts, @
downthe compiter, awner of Total Security Systems,
Exteinal fingerprint an Thursday, October 26, from
reacers usvally plug 11:30 a.m. to 1230 pom. {ET). A
into a USB port. qQuestion-and-answer sesslon will
- folkow Mellssa's presentation. For (b) Second Page of Newsletter
BMabile computers, | . mstion aboutthis webinar ar
smaetphones,  and to reglster,
smartwatches often have a buift- www securil SmartArt
in fingespsint reader. Lising thelr graphic
fimgerprint, users can unfock the | 1aut 15504 T
computer or device, sign nameplate L & Morthly Mewsletrer Security Trends
programs and websites via B LTS PP PRI AR

fingecprint instead of enterin !_I_ggmnaqles_. |- {Continued from first page)
i
user nome and password| o0 from fine B Fage Rucampiam Sile
some devies, even tes . " "7 )
Ta determine whethar a person
blood pressure and heart rate. adware, el i a legiti f
e i a legitimate user, 8 face
(Article continves onmext page) | 5919 recognition system captures

] / E vertical rule ]/

(a) First Page of Newsletter

their five face image snd com-
pares it with a stored image,
Serme buildings yse face recognic
tion gystems Lo secure access
to roams. Law salorcement,
survaillare systems, and air-
ports often yie Face recogni:
tion ta pratect the public. Some
mohile devices use face recogni
tion systems to unkack the device.
Face recognition programs are
becoming more sophisticated
and can recogreze people with or
without theer glasses, makeup, ar
Jjewelry, and with new hairstyles.

[EETT er
Hand geomatry syitems measore
the shage ard size of a person’s
hand, Because these systems can
be expensive, they often are vied
in larger companies to track
workers” time and attandance or
a5 secunity devices. Cafleges use
hand geomatry systems to verify
students’ identities. Daycare cen-
ters and hospital nurseries use
thee 1o identify parents who pick
up their children.

N0 Wil s ALGS Syslam
A voice verfication system will
compare & person’s live spesch
with their #tored voice pattern,
Larger organizations somatimes
use wice verification systems as
timn and attendance devices.
Many companes also use this
technology for sccess to sensitive

files and networks, To secure
phone  banking  transactions,
some financial services use voice
verification systems.

i

ericalive

syl G

A signature vedfication system
tecognizes the shape of your
handwritten signature, as well as
measures the pressure exerted

deal with highly sensitive data,
government security organiza.
tions, and the military. Some
organzations  use  retinal
scanners, which work sime
larty bua instead scan patterns
of blood vessels in the back cf the
retina.

Bivengdes Deyices
Biometric dewices are gain-
ing popularity as & security
precaution biecause they ace a
virtually foolproof method tover.
ify anidentity. For example, some
grotery stores, retail stores, and
gas stations uie biometric pay-
ment, where the customer’s fin-
gerprint it read by a fingerprint
reader (hat is linked to & payment
mathad, such a5 a checking ac-
<ount or credit card.

Users can forget their user names
and passwords. Badges, identifi-
cation cards, and keys can be lost,
rapied, duplicated, or stolen. Per-
sonal characteristics, by eantrast,

and the maotion used 1o write the 3

signature. Signature verification | 2'® Unique and tannat be forgat.
systemsuse aspacialized penand | N Of misplaced,

tablet. Sig ificationsys- | gj ic devices, , do
tems often arg uted to reduce have some disadvantages. If you

fraud in financial institutions.

ynitic

¥ Frlem
High security areas often ute iris
ecognition systems. The camers
i1 &n iris racognition system uses
iffs recognition technology to
read pattemns intheirisof the aye.
Thess patterns are as unique s a
fingerprint. Ins recogmition sys-
tems are quite expensive snd are
wsed by financial institutions that

cut your finger, a fingerprint
resder might reject you as a legit-
imate user, Hand geometsy read-
&rs can transmnit germs. i you are
mRrvous, & signatyre might not
match the one an Ble. If you have
4 sarg throat, a voice recognition
system might reject you, Many
peaple are uncomiortable with
using an iris o retinal scanner.

Figure 7-1
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To Run Word and Change Word Settings

If you are using a computer to step through the project in this module and you
want your screens to match the figares in this book, you should change your screen's
resolution to 1366 x 768. The following steps run Word, display formatting marks, and
change the zoom to page width.

RS o Run Word and create a blank document in the Word window. If necessary, maximize

The Riblon am.i the Word window.
Screen Resolution
Word may change how the e If the Print Layout button on the status bar is not selected, click it so that your screen

groups and buttons wit_hin the is in Print Layout view.
groups appear on the ribbon,

depending on the computer e
or mobile device’s screen
resolution. Thus, your ribbon

may look different from the . . . . .
ones in this book if you are To display the page the same width as the document window, if necessary, click the

using a screen resolution Page Width button (View tab | Zoom group).
other than 1366 x 768.

1f the ‘Show/Hide T’ button (Home tab | Paragraph group) is not selected already, click
it to display formatting marks on the screen.

To Change Spacing above and below Paragraphs
and Margin Settings

Recall that Word is preset to use standard 8.5-by-11-inch paper, with 1-inch
top, bottom, left, and right margins. In earlier modules, you changed the margins by
selecting predefined settings in the Margins gallery. Ior the newsletter in this module,
all margins (left, right, top, and bottom) are .75 inches, which is not a predefined
setting in the Margins gallery. Thus, the following steps set custom margins.

o Display the Layout tab.

a Click the Adjust Margins button (Layout tab | Page Setup group) to display the
Margins gallery and then click Custom Margins at the bottom of the Margins gallery
to display the Page Setup dialog box.

9 Change each value in the Top, Bottom, Left, and Right boxes {Page Setup dialog box) to
.75 (Figure 7-2).

G Click the OK button to change the margin values.

...... 5 = Margins tab

gdiu“ Margins - ,.. _. ¥ ]— .-.- Page Setup, r X r £ align~
utton 2 - L
taegi o i e Col Selecti
n‘gms Onn:ﬂlcn Sl:e |.: My Paper Layout ;:"n:n
3g¢ telup  Marging Luange
| Tap 5 e Boltem 75 g
Page Setup |, et T t Bk it :
group | Gutter 1 Gutter po, Lait w
E ) Orantatisn
i @ margin settings
= '3 entered
hl Podtragt Landgeape
Pages
Liuttiple pages: Hormat ~
Pignesr
Note: To help you locate screen
e asucdhoncsuch s butons and OK button
ions, su
L Apphitar Whele dotument
commands, this book uses red boxes "
to point to these screen elements. st o ottt
P e L e ———— e T —

Figure 7-2
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To Change Theme Colors BTW

N . . . Touch Screen
I'he newsletter in this module uses the Frame theme. The following steps

Word Module 7

Differences
change the theme to Frame. The Office and Windows
interfaces may vary if you are
. . using a touch screen. For this
@ Display the Design tab. reason, you might notice that
@ Click the Themes button (Design tab | Document Formatting group)} and then click the function or appearance

of your touch screen differs
slightly from this module’s
== = I - presentation.

Frame in the Themes gallery to change the document theme.

Creating the Nameplate

The nameplate on the first page of this newsletter consists of the information above
the multiple columns (shown in Figure 7 La at the beginning of this module). In this
project, the nameplate includes the newsletrer title, Security Trends, an image of a lock,
and the issue information line.

"The following sections use the steps outlined below to create the nameplate for
the first page of the newsletter in this module.

- Enter and format the newsletter title using WordArt.
Set custom tab stops for the issue information line.
Enter text in the issue information line.

Add a horizontal rule below the issue information line.

L T S R

Insert and format the image.

How should you design a nameplate?
A nameplate visually identifies a newsletter. It should catch the attention of readers, enticing them to read a newsletter, Usually,
the nameplate is positioned horizontally across the top of the newsletter, although some nameplates are vertical. The name-

plate typically consists of the title of the newsletter and the issue information line. Some also include a subtitle, a slogan, and a
graphical image or logo.

Guidelines for the newsletter title and other elements in the nameplate are as follows:

CONSIDER THIS %

* Compose a title that is short, yet conveys the contents of the newsletter. In the newsletter title, eliminate unnecessary words
such as these: the, newsletter. Use a decorative font in as large a font size as possible so that the title stands out on the page.

* Other elements on the nameplate should not compete in size with the title. Use colors that complement the title. Select easy-
to-read fonts.

* Arrange the elements of the nameplate so that it does not have a cluttered appearance, If necessary, use ruling lines to
visually separate areas of the nameplate.

1 CREATE NAREPLATE FOR FIRSY PAGE | 2 FORMAT FIRST PAGE | 3 CREATE PULL-QUOTE

To | nsert Wo rdA rt 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

In Module 3, you inserted a shape drawing object in a document. Recall that a drawing object is a graphic
you create using Word. Another type of drawing object, called WordArt, enables you to create text with special
effects, such as shadowed, rotated, stretched, skewed, and wavy effects.

This project uses WordArt for the newsletter title, Security Trends. Why? A title created with WordArt is
likely to draw the reader’s attention. The following steps insert WordArt.
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(1

» Display the Insert tab.

lnser‘ttab -
e e T
L i bl

o Click the Insert WordArt button
{(Insert tab | Text group) to

e [ [ [ 0

. [ Elank Page : ; 14 WordArtp.,  EdiDate & Time
display the Insert WordArt Epagemet T Lone 5"{F' B &
gallery (F19Ure 7-3) Pages Tables Justratiol ¢ & Footer A '

< Once | select a WordArt style, can | Te“ group / A A A
3 customize its appearance?
Yes, The next steps customize the A A A /}&
. N -

WordArt styie selected here,

WaordAr style
1o be selected

Figure 7-3

:[ Drawing Tools Format tab
automatically appears when WordArt

(2

s Click 'Fifl - Teal, Accent 1, Outline - ]
Background 1, Hard Shadow - B some e et Rebere il L W s
Accent 1’ in the WordArt gallery
{third WordArt style in iast row)
to insert a drawing object in
the document that is formatted
according to the selected
WordArt style, which contains the E,,dm drawing

| +"+7 Edit Shape = TR S Shape Rl A HiTes
, > & 5+ EDDraw Text Box AR abe L7 Shape Cutfine - A jh - B g
Lo yrs D S Shape Effects - T B- SOt
tnsert Shapes Shape Styles i) wianges Shyles

object inserted in
placeholder text, Your text here | 2 "% ——

(Figure 7-4). ; - it . text

N pe—
?Type Security Trends fo \ o Y@Uftteﬁxtimh{errejt7 sizing

replace the selected placeholder handles
text in the WordArt drawing

object {shown in Figure 7-5). s o )

<« |\What if my placeholder text no
g longer is selected? - ———
Drag through it to select it. Figure 7-4

How do | correct a mistake in the WordArt text?
You correct WordArt text using the same technigues you use to correci document text.

To Resize WordArt

You resize WordArt the same way you resize any other graphic. That is, you can
drag its sizing handles or enter values in the Shape Height and Shape Width boxes.
The next steps resize the WordArt drawing object.

o With the WordArt drawing object selected, if necessary, display the Drawing Tools
Format tab.

9 Change the value in the Shape Height box to 1.44 and the value in the Shape Width
box to 7 (Figure 7-5).
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| Drawing Tools

Shape Height
Format tab

and Shape
Width boxes

bt

£¥ShapefFilt +

+ [ Shapt Outfine - A A

Q Shape Effects +
Shage Styles o

© H et Direction- [
— - [lagnteon- o £ 5end Bacward -
Position VWap
+ 62 Craate lank .

HordAst Slytes n Tew #rrange

1Bnng Forward - I Align -

Ted - (il Selection Pane kRotate -

-
o
P
o
Qi
=5
S
D
s

i2

A\

| object selected

{
= = 1 1
S@cC § rendads|@
".:,ws'etge-'d /S)e:chUJrgty s i:‘
title entere,
'.__..-u-""""r-_-_““._—_“‘_"“"“"“--.._. — e e

Figure 7-5

To Change the Font and Font Size of WordArt Text

WordArt drawing

and resized

You change the font and font size of WordArt text the same way you change the
font and font size of any other text. That is, you select the text and then change its font
and font size. The following steps change the font and font size of WordArt text.

o Select the WordArt text, in this case, Security Trends.
e Change the font of the selected text to Bernard MT Condensed {or a similar font).

e Change the font size of the selected text to 72 point (shown in Figure 7-6).

To Change an Object’s Text Wrapping

When you insert a drawing object in a Word document, the default text wrapping
is Square, which means text will wrap around the object in the shape of a square.
Because you want the nameplate above the rest of the newsletter, you change the text
wrapping for the drawing object to Top and Bottom. The following steps change a
drawing object’s text wrapping.

o With the WordArt drawing object selected, click the Layout Options button that is
attached to the WordArt drawing object to display the Layout Options gallery.

9 Click ‘Top and Bottom’ in the Layout Options gallery so that the WordArt drawing
object will not cover the document text; in this case, the paragraph mark moves below
the WordArt drawing object {Figure 7-6).

9 Close the Layout Options gallery.

BTW

Deleting WordArt

If you want to delete a
WordAst drawing object,
right-click it and then click
Cut on the shortcut menu, or
select the WordArt drawing
object and then click the Cut
button {Home tab | Clipboard
group).
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Layout Options

- i ,_.-i_W:rrth(rit text {— | WordArt drawing button
! changed selecte = / object selected
10 72-point i <2 ) . a . R 0 / J
Bernard MT i
Condensed | > 3 G e Close
font = . J ! : I ol wavout cprions x4 L
; ) . 1aLine with Text 1
1 i L
o J ? ~ | Layout
I ! T == Options
A AL N v [
o : ) I 4"\ = =
1 : : =3
[ . T?p an: Bottom % Move with 18
| paragraph mark moved below Gelecte Far pesition o0
v WordArt drawing object because text Fage
wrapping is set to Top and Bottom J
L 2 : b S vt
—— L e— ——
Figure 7-6
| CREATE MAMEPLATE FOR FIRST PAGE | 2 FORMAT FIRST PAGF | 3 CREATE PULL-QUOTE
To Cha nge the Wo rdAr‘t Fi“ color 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SLCOND FAGE | 6 ADD PAGE BORDER

The next step is to change the color of the WordArt text so that it displays a teal and orange gradient fill
color. Gradient means the colors blend into one another. Word includes several built-in gradient fill colors,
or you can customize one for use in drawing objects. The following steps change the fill color of the WordArt
drawing object to a built-in gradient fill color and then customize the selected fill color. Why? Using a gradient
fill color will add interest to the title.

L)

» With the WordArt drawing object selected, click the Text Fill arrow (Drawing Tools Format tab | WordArt Styles group) to
display the Text Fill gallery.

: |
. Text Fill button ©

< | The Text Fill gallery
g did not appear. Why e . ] o
(not? i esign | Lyt el (2 Tubhe L L
T <4 Edit Shope - irecti I - LI CE
| Be sure you click the b P 0] TextFill
Text Fill 2 o vl teh = Ll Deaar Tet Bax ) © H dstomac PR I i
Fi it * Theme Cators - E‘ga Y dne "k Retate «

is to the ||i'|- af | N | aREm Arrangs

|the Text Fill bution. o | : R
[If you mistakenty i ‘S’:I;‘Jlgi‘;rrtoup ] H '
| Fill WordArt - - o FUEEETEE

il + »
click the fext

Drawing Tools

drqwmg Siandard Codors .
W, n, Word places | object mm rEoEED | Gradient
- l selected Hefill qalle |
autt fill in th o i - v
seted et - W Bhoee Fill Celeds. =
& o v HeGradiend
stead of cisplaying

the Text Fill gatlery
| Uight Varistions

= Point to Gradient
in the Text Fill
gallery to display g ©
the Gradient gallery 1
(Figure 7-7).

Drask Warlathons

F B |
EORas

More Gradients

] =
(L [dore Gordionti-. a—oJ
command

L I

Figure 7-7
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e Click More Gradients in the

Gradient gallery to open the
Format Shape task pane. If
necessary, click the Text Options
tab in the Format Shape task
pane and then, if necessary, click
the ‘Text Fill & Outline’ button.
If necessary, expand the Text Fill
section.

¢ Click Gradient fill in the Text Fill

section to display options related
to gradient colors in the task pane
(Figure 7-8).

4

¢ Click the Preset gradients button

in the Format Shape task pane
to display a palette of built-in
gradient fill colors (Figure 7-9).

e

# Click ‘Radial Gradient - Accent 5

Q&A

{bottom row, fifth column) in the
Preset gradients palette to select
the built-in gradient color, which
shows a preview in the Gradient

stops area (Figure 7-10).

What is a gradient stop?
A gradient stop is the location
where two colors blend. You can
change the color of a stop so that
Word changes the color of the
blend. You also can add or delete
stops, with a minimum of two stops
and a maximum of ten stops per
adient fill color.

Creating a Newsletter with a Pull-Quote and Graphics Word Module 7 WD 385

Format Shape
task pane

Text Options
tab selected

“Text Fill & Qutkine’ |

Format Shape .

button selected \Shlplﬂpﬁons Text Options
A b

iy A TextFl - Text Fill area
expanded
| Gradient fill option Mafill
- | button selected Sofid fil
] Tl Gradient fill
Wi Bl b
Lo i Pueset gradients lD i
Type Linear b¢
e Ruection { (W
I
preview of . -
| selected options Angle I—EG o

Gradient stops

0—mn v &

Color
Pasition

Iransparency |

LR

03

5

Brightness

Figure 7-8

Preset
gradients | ——
button

* Grad

| gradient fill colors

\_J palette of built-in
St o

Pyriet gradients

| preset color
to be selected

i i

Figure 7-9

T -—""”'I preview of how Word B —

blends colors to create |
I_ sefected gradlent effect b 53]
£ 4 Textfal -

Bo fill
Fetid il

& dradient 1]

Peeset gradients -

i Type Radial hes

Direction -

Gradient adds a stop g
stops area k\‘ﬁ -
o J radient stops

stops show where g

P =1 152 -
two colors blend | e

Transparency |

Brightness

rer;ioves . —L‘-J

selected stop

Figure 7-10
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(6)

s Click the second gradient stop to
select it and then click the Color
button to display a Color palette,
from which you can select a color
for the selected stop (Figure 7-11).

7]

» Click ‘Orange, Accent 4, Darker
25%" (fifth row, eighth column)
in the Color palette to change the
color of the selected stop and the
gradient between the selected
stop and the next stop.

colar to be
selected for
second stop

second gradient
stop selected

Figure 7-11

Precel m-rd' Thame Colors
BEEmocaEa '.

Durection l | I i

" Gradient le Standard (olors
Mo cmesann

t.i _[ura Cnlbrs
e
=" Color h

Pgsition

# Click the rightmost gradient stop to select it and then click the Color button to display a Color palette. Click
‘Orange, Accent 4, Darker 25% (fifth row, eighth column) in the Color palette to change the color of the selected
stop and the gradient between the selected stop and the previous stop.

g Can | move a gradient stop?
g

transparency of any selected stop.

®

» Click the Direction button to
display a gallery that shows
a variety of directions for the
gradient colors (Figure 7-12).

©

i colors changed
| in gradient
| effect |

Yes. You can drag a stop to any location along the color bar. You also can adjust the position, brightness, anc

Close
button

Format Shape
Shape Options  Text Options

AL [E

4 TextFiB ¢

‘From Top
Left Corner’
to be selected

Mo i
Solid fill

. di

Direction
button

ueset gradients

gallery |

these settings

can be changed ————

{ for each stop

Figure 7-12

Type

Dircetion

Caler e
Pgsition win S
Iransperency | 13 M

Brightness k¥ rightmost

stop color | |
changed

s Click ‘From Top Left Corner’ (rightmost direction) in the Direction gallery to specify the direction to blend the colors.

» Click the Close button in the task pane.

o Click the paragraph mark below the WordArt drawing object to deselect the text so that you can see its gradient fill

cotors (Figure 7-13).

- Seal

insertion
point

blend of teal and orange

colors changed to gradlent

Figure 7-13
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1 CREATE NAMEPLATE FOR FIRST PAGE ‘ 2 FORMAY FIRST PAGE | 3 CREATE PULL-QUOTE .g

j TO Change the Wo rdArt Shape 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER |8
b=

B Word provides a variety of shapes to make your WordArt more interesting. The following steps change =
E o

the WordArt shape. Why? The WordArt in this newsletter has a wavy appearance.

i) @ TR

o Click the WordArt drawing object T Cltals o E g :
BT) to select it. N e —
, ; WordArt shape } - N hForward - |
= If necessary, display the Drawing <h:|r19est:: Dauble -u] v A IA <] Adign Test - /4;.093;:? Tl Backward
| Tools Format tab. l?i:":frl;i’.?ﬁg'f“g ' N i A s':{ Transform
- . transform effect T ! Shadawy ' gallery |
= Click the Text Effects button to yvpich you are i i “T
) (Drawing Tools Format tab | L ETEY L styles group - 2
- WordArt Styles group) to display \ I 3\ g s
:} the Text Effects gallery. oo
4 . ] CE YF Path
. . X
# Point to Transform in the Text - A sonesin s 8 e S
-—:J Effects gallery to display the . it Ceiat ol
a » . War
b Transform gallery. | A, Jrwstorm ’
. . ' N F JYabcde abede abca. bede
D) = Point to ‘Double Wave 1” (third g e q
= effect, fifth row in Warp area) in the L command Jalwde abede Mn eniu
s Transform gallery to display a live I Warp_area__| _ i
B preview of the selected transform e St Lo
effect applied to the selected J Lk SR bede abell
drawing object (Figure 7-14). }
- I abege alale abede | abede
Experiment
7 H H H | A= 5 l_ e abede  abede a e |
- ¢ Point to various text effectsinthe |__——— P ——— TR T e

Transform gallery and watch the Fiaure 7-14 'l?fnubleWave v
) selected drawing object conform 9 =
to that transform effect.

B 12

-—-j * Click ‘Double Wave 1" in the Transform gallery to change the shape of the WordArt drawing object.

To Set Custom Tab Stops

'_F‘\I 1 CREATE NAMEPLATE FOR FIHSY PAGE I 2 FORMAT FIRST PAGE I 3 CREAYE PULL-QUOTE
EE) Using the Ta bs Dia Iog Box 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAY SECOND PAGE | 6 ADD PAGE BORDER
I The issue information line in this newsletter contains the text, Monthly Newsletter, at the left margin

) Y ' g
[

and the issue number at the right margin (shown in Figure 7- Ia at the beginning of this module). In Word,
a paragraph cannot be both left-aligned and right-aligned. Why? If you click the Align Text Right’ button (Home
tab | Faragraph group), for example, all text will be right-aligned. To place text at the right margin of a left-aligned
paragraph, you set a tab stop at the right margin.

One method of setting custom tab stops is to click the ruler at the desired location of the tab stop, which
you learned in an earlier module. You cannot click, however, at the right margin location. Thus, the following
steps use the Tabs dialog box to set a custom tab stop.
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= If necessary, display the Home tab.

» Position the insertion point on
the paragraph mark below the
WordArt drawing object, which
is the paragraph to be formatted
with the custom tab stops.

» Click the Paragraph Settings
Dialog Box Launcher to display
the Paragraph dialog box
{Figure 7-15).

2]

» Click the Tabs button {Paragraph
dialog box) to display the Tabs
dialog box.

» Type 7 inthe 'Tab stop position’
text box (Tabs dialog box).

# Click Right in the Alignment area
to specify alignment for text at
the tab stop (Figure 7-16).

3]

# Click the Set button (Tabs dialog
box) to set a right-aligned custom
tab stop at the specified position.

# Click the OK button to set the
defined tab stops.

Other Ways

Paragraph
,:l_-“,! dialog box
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Figure 7-16

1. Click desired tab stop on ruler

2. Right-click paragraph (or, if using touch, tap 'Show Context Menu’ button on mini toclbar),
click Paragraph on shortcut menu, click Tabs button (Paragraph dialog box), enter desired
settings, click OK button
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To Enter Te_>_(_t

The following steps enter the issue information line text.

o With the insertion point on the paragraph below the WordArt, change the font to
Century Schoolbook (or a similar font) and the font size to 10 point,

9 Type Monthly Newsletter on line 2 of the newsletter,

If requested by your instructor, enter your name instead of the word, Monthly.

o Press the TAB key and then type Issue 15 to complete the issue information line
{Figure 7-17).

W E IO

LM indicates TAB

key was pressed \
Monthly Newsletter —

T —— . i

v Issue 15

text entered _—
R T— i -

Figure 7-17

The nameplate does not appear to extend to the right margin. Why not?
i you have formatting marks displaying, the paragraph mark consumes space at the
right margin. To see how the nameplate will print, turn off formatting marks.

<
o
o

1 CREATE MAMEPLATE FOR FIRST PAGE | 2 FORMAT FIRST PAGE | 3 CREATE PULL-QUOTE

To Border One Edge of a Paragraph

4 CREATE NAMEFLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

In Word, you use borders to create ruling lines. As discussed in previous modules, Word can place borders
on any edge of a paragraph; that is, Word can place a border on the top, bottom, left, and right edges of a

paragraph.

One method of bordering paragraphs is by clicking the desired border in the Borders gallery, which you
learned in an earlier module. If you want to specify a particular border, for example, one with color, you use the
Borders and Shading dialog box. The following steps use the Borders and Shading dialog box to place a border
below a paragraph. Why? Iu this newsletter; the issue information line bas a 3-point diagonally striped teal border below it.

1

# Click the Borders arrow {Home
tab | Paragraph group) to display
the Borders gallery (Figure 7-18).

: =
' Home tab
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RTINS Borders
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Figure 7-18
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a 8orders and $hading |

s Click ‘Borders and Shading’ in ___HH,_..-!__d!a.lc'g w‘ o T gt
the Borders gallery to display the ' [4 ' o
LSt_yle list

Borders and Shading dialog box.

| Setting area J Borders and Shading H *
# Click Custom in the Setting area Bocdurs  PapeBorder  hading
(Borders and Shading dialog box) s 1 T ton G _FEEETS
because you are setting just a = - eSSl | |peviewet

bottom border.

: options selected |
__'ﬂ indialog box

= Scroll through the Style list and
click the style shown in Figure 7-19,
which is a diagonally striped line
for the border.

sele
o styl

cted
e
; d Bottom Border Jadi =
il £l Apply te:

Custom B0 —— £ button |  Issue
# Click the Color button and then selected fl/ i == R
click 'Teal, Accent 5, Darker 50%" — ——
(ninth column, bottom row) in the Z‘#ﬁ.’;:&’iﬁ?’;‘fﬂfen
Color gallery. style was selected

oK Lancel

= Click the Bottom Border button in
the Preview area of the dialog box
to show a preview of the selected
border style (Figure 7-19).

Figure 7-19

< | What is the purpose of the buttons in the Preview area?
g. They are toggles that display and remove the top, bottom, feft, and right borders from the diagram in tha Praview area.

e

¢ Click the OK button to place the defined border on the paragraph containing the insertion point (Figure 7 -20).

[ —
| insertion
| point

bottom Monthiy Mewsletter - Issue-l
border -
added

Figure 7-20

< | How would | change an existing border?

g You first remove the existing border by clicking the Borders arrow (Hormne tab | Paragraph grouip) and then clicking
the porder in the Borders gallery that identifies the border you wish to remove. Then, add a new border as
| described in these steps.

| Other Ways

1. Click ‘Borders and Shading’ button (Design tab | Page Background group), click Borders tab {Borders and Shading dialeg box), select desired
border, click OK button

TJo Insert a Picture

The next steps insert an image of locks in the nameplate.

o Display the Insert tab.

9 Click the Online Pictures button {Insert tab | lllustrations group) to display the Insert
Pictures dialog box.

@
6.
©
@
©
@
@
@
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e Type locks in the Search box (Insert Pictures dialog box) to specify the search
text and then click the Search button to display a list of images that match the entered
search text.

o Scroll through the list of images to locate the one shown in Figure 7-21 (or a similar
image), click the image to select it, and then click the Insert button (Insert Picture
dialog box) to download the image, close the dialog box, and insert the selected
image at the location of the insertion point in the document.

What if | cannot locate the same image as in Figure 7-217

Click the Cancel button to close the dialog box and then click the From File button
(Insert tab | fllustrations group) to display the Insert Picture dialog box, navigate to
and select the 1383900176-2400px.png file on the Data Files, and then click the Insert
button (Insert Picture dialog hox) to insert the picture.

Q&A

What if my inserted image is not in the same location as in Figure 7217

The image may be in a different focation, depending on the position of the insertion
noint when you inserted the image. In a later section, you will move the image to a
different location.

To Change the Color of a Graphic

The following steps change the color of the graphic (the locks) to a shade
of gold.

|
]
i

o With the graphic still selected, click the Color button {Picture Toois Format tab | Adjust
group) to display the Color gallery {Figure 7-21).

@

e Click ‘Gold, Accent color 2 Light' (third color, bottom row} in the Recolor area in the
Color gallery to change the color of the selected graphic.

ﬁ";:

Picture Tools |
Format tab

R o R

@ rlq £ iy Fresy e [ Pictwe Border - [T .-1 3 Forward I3 Angn - | il-. ;
nk-.- ﬁcm[} £ Change Picture : = | o :_“';"!;u-zolor gallery beretsene o g o g i '

a.(Z',fﬁf.T.d Color Satutation . ittt s e o [ SelectonPane ChRotster (P il
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— gf;ﬂ:: M Glo]elalalalaldlala]ala]ala] Issue 15 :
@ Reqolor
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Figure 7-21
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1 CREATE BAMEPLATE FOR FIAST PAGE | 2 FORMAT FIRST PAGE l 3 CREATE PULL-QUOTE

To Crop a G ra phic 4 CREATE NAMEPLATE FOR SECOMD PAGE | 5 FORMAT SECOND PAGE | 6 AGD PAGE BORDER

The next step is to format the image just inserted. You would like to remove the rightmost lock from the
image. Why? You want just one lock to appear in the newsletter: Word allows you to crop, or remove edges from, a
graphic. The following steps crop a graphic.

@ Pictl..l;e. T_ools j
» With the graphic selected, click i 5
the Crop button (Picture Tools

Format tab | Size group), which

et AT R

23 Pictyse Eftect >

places cropping handles on the * B panbapeut oo W o Cr:" T - =S
image in the document, T - it A B s oa
;(a What if | mistakenly click the Crop . Lssue 1| Size group _

o) arrow?
Click the Crop button.

s Position the pointer on the right-
middle cropping handle so that
it looks like a sideways letter T
(Figure 7-22).

cropping ||
handles

| pointer on
right-middle
| cropping handle

@

» Drag the right-middle cropping
handle inward to the location

Picture Tools
4 Format tab

T e

L4 -‘l"r:ﬂil-_l . T

PR b N e i
0 Tel e what yolwisl r:?q&,.

sqnm b

shown in Figure 7-23 to crop the mn e pmm e premy L PetweBode- [BR . G L auga- QT TR
i i o g anet g - CFPctwebtei-  —— T E ' 3 &
nghtmost IOCk from the Image' = i [, Pictare tagout » P“:‘mn '.I“‘i::F £ Selectian Pane “kRotate - Cr::p ﬁ“i
@ -Aw Srat E E Sz LY
#» Click the Crop button (Picture | e TV ST .\ S
Tools Format tab | Size group) ]s:u oroup |

to deactivate the cropping tool,
which removes the cropping
handles from the selected image.

il

image cropped so

that rightmost lock
no longer appears

Figure 7-23

: Other Ways

1. Right-click graphic, click Crop button on mini toolbar, drag cropping handles, click Crop button

@ &

j

[4
!

i

SICEREEEEELIEEEEEEEEREERER N




S PeEETEEOEE

P @8 8

B B8 &

B 8 @ 8

3

&

C 8 @ @

Creating a Newsletter with a Pull-Quote and Graphics Word Vodule 7 WD 393

To Change an Object’s Text Wrapping and Size

@

0 ©

When you insert an object (image) in a Word document, the default text
wrapping is In Line with Text, which means the object is part of the current paragraph.
Because you want the lock image behind the newsletter title, you change the text
wrapping for the image to Behind Text. The next steps change a drawing object’s text
wrapping and also change its size.

With the lock graphic selected, click the Layout Options button attached to the
graphic to display the Layout Options gallery.

Click Behind Text in the Layout Options gallery so that the image is positioned behind
text in the document.

Close the Layout Options gallery.

Change the values in the Shape Height and Shape Width boxes (Picture Tools Format
tab | Size group) to .6” and .51", respectively.

To Move a Graphic

@

(2

"The clip art image needs to be moved up so that the bottom of the lock is on the
s in the word, Trends, in the newsletter title. The following steps move a graphic.

Hide formatting
marks so that you
can see exactly
where the letter s
ends,

Drag the graphic
to the location
shown in

Figure 7-24.

2 X Cu

L

# ‘ShowrHide '
“ 1 button not selected

Ceitel Bedy

image inserted,
cropped, and

moved so that it et L £
can be displayed \‘h ] =
k .

behind text

Figure 7-24

To Use the Selection Task Pane

1 CAEATE NAMEPLATE FOR FIRST PAGE | 2 FORMAT FIRST PAGE | 3 CREATE PULL-QUOTE

4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

©

The next step is to rotate the lock image, but because it is positioned behind the text, it may be difficult to
select it. The following step opens the Selection task pane. Why? The Selection task pane enables you easily to select
iterns on the screen that are lnyered bebind other objects.

» If necessary, click in the graphic to
display the Picture Tools Format tab.

+ Click the ‘Display the Selection
Pane’ button (Picture Tools Format
tab | Arrange group) to open the
Selection task pane (Figure 7-25).

Ficture 1

| Picture Tools ‘Display the Selecti
w7 Formattab [ af / pan';- tzru:lt:n Feven

% “ P A I £+ L

0 Send fgciovard -

Position  Wea .4 U Crop 7=
S E}m@ ARotater b e O8I
Atange

L7 i -
: e e U L # Piclure Border
el aeerl g - ¥ Picture Effects -

* EL Piclure Layzut =

Selection
task pane

Pigture Sty Sz n -

Arrange /

group | selects WordArt — Selection
| your assigned Shaw AN | Hide 33 il
| name may differ

G « I TetBor 1 b
selects lock image — your | o= Picture 2 -
_‘—“‘---n.-—_,‘ilgned name may differ =

toggle buttons that L7
show or hide object |

e e ———

Figure 7-25

Word Module 7
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@ Experiment

» Click Text Box 1 in the Selection task pane to select the WordArt drawing object. Click Picture 2 in the Selection task
pane to select the lock image.

« | What are the displayed names in the Selection task pane?
g.:Word assigns names to each object in the document. The names displayed on your screen may differ.

1 CAEATE MAMEPLATE FOR FIRST PAGE 2 FORMAT FIRST PAGE 1 3 CREATE PULL-QUOTE

To Rotate a G ra ph ic 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

The following steps rotate a graphic. Why? You would like the lock image angled inward a bit more.

(1

. . . pointer changes to circular .
s If necessary, click Picture 2 in the arrow wrapped around |- e e ) ooz
. rotate handle when you TR !
Selection task pane to select the point to rotate handle \ Selection g
lock image. 1(‘& Show All | Hide All il
= Position the pointer on the graphic’s Ol Text Box 1 -
rotate handle (Figure 7-26). Picture 2 g

) L8 | graphic |
; [ selected |

Figure 7-26

e Close

e o button ~

» Drag the rotate handle rightward e [iR e '_"“““‘-«m.,__________><‘ 1
[l

and outward to rotate the graphic Selection ik

slightly as shown in Figure 7-27. q% Show &1t | Hide Al i
(You may need to rotate the

i H Y i B P — O e Text Box 1 =
:qraphlc a .few tlme§ to position it L i, i Pictire 3 B
in the desired locatu_:n.) |£u drag pointer

Can | drag the rotate handle in
any direction?

You can drag the rotate handle
clockwise or counterclockwise.

Q&A

Figure 7-27

What if | am using a touch screen?
Because the rotate handle is not avaiiable on a touch screen, you enter the degree of rotation in the Size dialog
box. Tap the Rotate Objects button (Picture Tools Format tab | Arrange group) to display the Rotate Objects menu,

tap ‘More Rotation Qptions’ on the Rotate Objects menu to display the Size sheet in the Layout dialog box, change
the Rotation value to 14, and then tap the OK button.

= Click the Close button on the Selection task pane to close the task pane.
» Click somewhere in the issue information line to deselect the graphic.

# Save the title page on your hard drive, OneDrive, or other storage location using the file name, Security Trends
Newsletter.

Break Point: If you wish to take a break, this is a good place to do so. You can exit Word now. To resume at a later time, run Word,
open the file called Security Trends Newsletter, and continue following the steps from this location forward.
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Formatting the First Page of the Body
of the Newsletter

The next step is to format the first page of the body of the newsletter. The body of the
newsletter in this module is divided in three columns (shown in Figure 7~1a at the
beginning of this module). The first two columns contain the feature article, and the
third column contains announcements. The characters in the paragraphs are aligned
on both the right and left edges — similar to newspaper columns. The first letter in
the first paragraph is much larger than the rest of the characters in the paragraph.

A vertical rule separates the columns. The steps in the following scctions format the
first page of the body of the newsletter using these desktop publishing features.

T
A
S
°
Q
p=
o
o
2

What guidelines should you follow when creating the body of a newsletter?
While content and subject matter of newsletters may vary, the procedures used to create newsletters are similar:

* Write the body copy. Newsletters should contain articles of interest and relevance to readers. Some share information,
while others promote a product or service. Use active voice in bedy copy, which is more engaging than passive voice,
Proofread the body copy to be sure it is error free. Check all facts for accuracy.

CONSIDER THIS %

¢« Organize body copy in columns. Mast newsletters arrange body copy in columns. The body copy in columns, often called
shaking columns or newspaper-style columns, flows from the bottom of one column to the top of the next column,

+ Format the body copy. Begin the feature article on the first page of the newsletter. If the article spans multiple pages, use
a continuation line, called a jump or jJump line, to guide the reader to the remainder of the article. The message at the end
of the article on the first page of the newsletter is called a jump-to line, and a jump-from line marks the beginning of the
continuation, which is usually on a subsequent page

* Maintain consistency. Be consistent with placement of body copy elements in newsletter editions. If the newsletter contains
announcements, for example, position them in the same location in each edition so that readers easily can find them.

+ Maximize white space. Allow plenty of space between lines, paragraphs, and columns. Tightly packed text is difficult to
read. Separate the text adequately from graphics, borders, and headings.

» [ncorporate color. Use colors that complement those in the nameplate. Be careful not to overuse color. Restrict color below
the nameplate to drop caps, subheads, graphics, and ruling lines. If you do not have a color printer, still change the colors
because the colors will print in shades of black and gray, which add variety to the newsletter.

* Select and format subheads. Develop subheads with as few words as possible. Readers should be able to identify content
of the next topic by glancing at a subhead. Subheads should be emphasized in the newsletter but should not compete with
text in the nameplate. Use a larger, bold, or otherwise contrasting font for subheads so that they stand apart from the body
copy. Use this same format for all subheads for consistency. Leave a space above subheads to visually separate their content
from the previous topic. Be consistent with spacing above and below subheads throughout the newsletter.

« Divide sections with vertical rules. Use vertical rules to guide the reader through the newsletter.

+ Enhance the document with visuals. Add energy to the newsletter and emphasis to important points with graphics, pull-
quotes, and other visuals, such as drop caps, to mark beginning of an article. Use these elements sparingly, however, so that
the newsletter does not have a crowded appearance. Fewer, large visuals are more effective than several smaller ones. If you
use a graphic that you did not create, be sure to obtain permission to use it in the newsletter and give necessary credit to the
creator of the graphic.

To Clear Formatting

The next step is to enter the title of the feature article below the horizontal rule.
To do this, position the insertion point at the end of the issue information line (after
the 5 in Issue 15) and then press the ENTER key. Recall that the issue information line
has a bottom border. When you press the ENTER key in a bordered paragraph, Word
carries forward any borders to the next paragraph. Thus, after you press the ENTER
key, you should clear formatting to format the new paragraph as the Normal style. The
following steps clear formatting.
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@' Click at the end of line 2 (the issue information line) so that the insertion point is
immediately after the 5 in Issue 15. Press the ENTER key to advance the insertion point
to the next line, which also moves the border down one line.

@ If necessary, display the Home tab. Click the ‘Clear All Formatting' button (Home tab |
Font group) to apply the Normal style to the location of the insertion point, which in
this case moves the new paragraph below the border on the issue information line.

To Format Text as a Heading Style, Modify a Heading Style,

Below the bottom border in the nameplate is the title of the feature article,
Biometrics. The following steps apply the Heading 1 style to this paragraph, modify
the style, and adjust the paragraph spacing.

If necessary, display formatting marks.

With the insertion point on the paragraph mark below the border, click Heading 1

{Home tab | Styles group) to apply the Heading 1 style to the paragraph containing
the insertion point.

reflect these changes.

@ Increase the font size 20 point. Bold the paragraph. Update the Heading 1 style to
@ Type Biometrice asthe title of the feature article.

Display the Layout tab. Change the Spacing Before box to 18 pt and the Spacing After
box to 12 pt (Figure 7-28).

Rederences Mailings Heviow

"= Breaks ~ spacing before
$0) Line Mumbers - and after current
Margins Orientation  Size  Columns : . paragraph change
- = - &5 bz Hyphenatien - 0 -

Page Setup = Paragraph
s s v o ——r - T -
Monthly

feature article

title entered
and formatted \

: iometricsh]\

Figure 7-28

Columns

When you begin a document in Word, it has one column. You can divide a
portion of a document or the entire document in multiple columns. Within each
column, you can type, modify, or format text.

To divide a portion of a document in multiple columns, you use section breaks.
Word requires that a new section be created each time you alter the number of
columns in a document. Thus, if a document has a nameplate {one column) followed
by an article of three columns followed by an article of two columns, the document
would be divided in three separate sections.

3
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How should you organize the body copy in columns? g:ﬂ
Be consistent from page to page with the number of columns. Narrow columns generally are easier to read than wide ones. =
5 Columns, however, can be too narrow. A two- or three-column layout generally is appealing and offers a flexible design. Try to have :
. between five and fifteen words per line. To do this, you may need to adjust the column width, the font size, or the leading (line w
spacing). Font size of text in columns should be no larger than 12 peint but not so small that readers must strain to read the text E‘
S R o — e L S — Fa
o
W]
2 FORMAT FIRST PAGE | 3 CREATE PULL-QUOTE
TO Inse rta Co nt] nuous Section Break 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORGER |
i The next step is to insert a continuous section break below the nameplate. Why? Inn this medule, the nameplate is
one colunm and the body of the newsletier is three columms. The term, continuous, means the new section should be on the

B same page as the previous scction, which, in this case, means that the three columns of body copy will be positioned
directly below the nameplate on the first page of the newsletter. The following steps insert a continuous section break.

o ‘lnsert Page
and Section b,
Breaks' button

Layout tab

E ¢ With the insertion point at the -
end of the feature article title R o s - O [ e BB e
(shown in Figure 7-28), press the B OHE ;E““':‘It i b B )
m ENTER key 1o position the insertion  |Mwms ofmmen sie columas "%° - . i i et BT

-1
.

point below the article title. - i e

L - Insert Page nnge
and e nad page Beging

R i JText Wrapping
Setup group) to display the Insert Zl Separme st weond sk co ek

paget, such 3§ CEETen et f1ome Eady 161

and Section
. . Breaks gall
E} e Click the ‘Insert Page and Section I'page setop B s it et ez ng e reskroaley
R = Brek ard Bogn in the nest ol
Breaks' button (Layout tab | Page | 9% B

Page and Section Breaks gallery
(Figure 7-29).

- Srction Bieaks

Hext Page
Ieseit @ vectan breas snd syt the new
SECTON CA TRE NE DROL

Cantinuous command creates

Cgnta - section break on same page
Inzart 3 i#ction Biesk snd BRI ThE A as previous saection
.:EI' 3 techith 2nthe e page.
tven Page
bk 0 Lot &b beesi sid ifan The ne
MEETLA 20 The AT et GRUREFC
ik
Month. ¢ rtuarsae -
ro s m—- N TR 5 S0 Cf Bledh, 30 SRAT the e

ELtEh 20 hE het 848 pumBered fege

-Biometricsq]

| insertion |
i e T —~—._,___‘_\_\_ _'_'_'_”"__a—-—'-" "—"—a-._\_‘_‘__‘_\_ s —

T—— . — ———

EE-]
—
2
=4
E
=

Figure 7-29

formatting
mark indicates
9 continuous
section break

&

¢ Click Continuous in the Insert Page
and Section Breaks gallery to insert
a continuous section break above
the insertion point (Figure 7-30).

-Biometricsq .\ — 7

insertion
point
Figure 7-30
E i 2 FORMAT FIRST PAGE | 3 CREATE PULL-QUOTE
- TO Cha nge the N um ber of Colu mns 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

i

The document now has two sections. The nameplate is in the first section, and the insertion point is in
the second section. The second section should be formatted to three columns. Why? The feature article and
announcenients appear in three columms that snake across the page. Thus, the following steps format the second
section in the document as three columns.

@ @
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@ . ‘Add or Remove -m“:.
. Columns’ button e e

e Click the ‘Add or
Remove Columns’ inlc e ey £} dlimy
button (Layout tab | |y Bl - Spacing ; .o N's

" B 3 : 5 - ¢m t S H ek o : o !I“ﬁm: v
Page Setup group) e Sae Tolmes e | 5 ] A o R (] B B S secion L
to display the Add - 3 2 Columns gattery | "8

or Remove Columns
gallery (Figure 7-31).

current section
should be three
columns

Page Setup
group

w) ([

!E!!!

Fight T l— !

1l More Columns
Mere Cebumne. — command displays
. v 4 Caolumns dialog box
o = i Ere

Section Break {Cortinuous

insertion
point

Figure 7-31

@

e Click Three in the

View Ruler
check box

Add or Remove rhenracn G, Mk noc SR Ao Sl il
i1 [ 0nePage ot = |

ij.umns galle[:y to zc.}m % e aes NE N%ge S_prr;l R T rE?os

divide the section . Mivgation Pane FoageWith it Al Gt e PR pyindowge -

containing the
insertion point in
three evenly sized
and spaced columns

Show Zoom Wanoan Kaeras

& Display the View
tab and then, if
necessary, click the
View Ruler check

-
. . ruler indicates column width L -\
-Biometrics§ | oftveeerentyspaced P

celumns in section 2 ‘/—_J
-
_-"—‘-'_'_‘—'\.a-l_-

box so that the I
rulers appear on the i .
screen (Figure 7-32). insertion LI

point

< | Why display the rulers?
o You want to see the column widths on the ruler.

\What if | want columns of different widths?
You would click More Columns in the Add or Remove Columns gallery, which displays the Columns dialog box, In
this dialog box, you can specify varying column widths and spacing.

IZ FORMAT FIRST FAGE 3 CREATE PULL-QUOTE

TO justify d Pa rag raph 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

The following step enters the first paragraph of the feature article using justified alignment. Why? The text
in the paragraphs of the body of the newsletter is justified, which means that the left and right margins ave aligned, like
the edges of newspaper columns.

O
@
@
@
(i
O

s T T T — TEETEr T e
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1)

* Display the Home tab.

o Click the Justify button (Home tab | Paragraph group) so that Word aligns both the left and right margins of
typed text.

* Type the first paragraph of the feature article {Figure 7-33): Biometric devices verify a person’s
identity by translating a behavioral or physical personal characteristiec, such as
a fingerprint, into a digital code that is compared with a digital code stored in
a computer or mobile device. If the digital code in the computer or mobile device
does not match the personal characteristic code, the computer or mobile device
denies access to the individual. and then pressthe ENTER key.

5 . SEEE 4] A Find -
Cotelifady} =[N« A A 7O EN T EE AW laameced asanced AaBE - 1 AQE sassca aasscen Aomscenn !

&_ o
t Li i c . Replace
| #ase Cromatbuney B 7 Mmoo Q- A. EEERE E- Do THuenal | THafge.. Hemdegl o Headng? o Tl Sublile  Sublief Emphins 3 e
Copagard [ Fanl fu Patagraph Tt e e Editing “
1. s g e TN el , Ei TR 4 [ e S G 0 T-T
right-edge aligned in . Paragraph

s B i o m et ri C S‘ justified Paragraph _I&junm Break [Conbinueus}

 Biometric. devices. verify. i
person’s-identity. by-translating-
& a-  behavioral- or- physical

. personal-characteristic, -such-as-
22::?;;'1:'“,1 a-fingerprint, into.a.digital code.
justified \ that-is. compared. with-a. digital.
alignment .

v code: stored- in- a: computer- or-

mobile device. If thedigitalcode.
in- the. computer. or- mobile-
device- does- not- match- the.
personal- characteristic. code,.
| the.computer.or-mobile-device-
’ . L denies-access-tothe.individual 4

| insertion | s 2y . : i g
Doint L n £ d : _ i ¥ . i
Lo T T R

Figure 7-33

< | Why do some words have extra space between them?
When a paragraph is formatt
right edges of the paragraph
words, change the colimn w

Q&

Other Ways

1. Right-click paragraph (or, if using touch, tap 2. Click Paragraph Settings Dialog Box Launcher {(Home 3. Press CTRL+)
‘Show Context Menu’ button on mini toelbar), tab or Layout tab | Paragraph group), click indents and
click Paragraph on shortcut menu, click ‘Indents Spacing tab (Paragraph dialog box), click Alignment
and Spacing’ tab {Paragraph dialeg box), click arrow, click Justified, click OK button

Alignment arrow, click Justified, click OK button

To Insert a Fi le in a COlumn 2 FORMAT FIRST PAGE | 3 CREATE PULL-QUOTE
of the N ewsletter 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE 6 ADD PAGE BORDER

The next step is to insert a file named Biometrics Article in the newsletter. Why? To save you time typing, the
rest of the feature article is located on the Data Files. Please contact your instructor for information about accessing
the Data Files. The following steps insert the Biometrics Article file in a column of the newsletter.

Woard Module 7
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(1

# Display the Insert
tab.

Insert

. . : LT3 Module 07 folder
* With the insertion e potend Qe | inpatsies folder
point positioned in i € o b ODaFie o Momanll setected
1
the left columnas - - Crganize »  tlewosder 2. 3@
shown in Figure 7-33, Bi P r— Dt j L ;‘f: Zosa
. X . a7 Brometrics At selected fite will be
sl i oL A @i ST | e tioaton [11700
(lnsert tab I Text 3 7da OneDrive B Security Trends Annguncements _Of :’nseﬂloﬂ point 1 fzed D
) to display the B0l ene -
group o i
f ar
Object menu, : b Neork
# Click 'Text from File' per ‘hHemes
on the Object menu afil
to display the Insert tha,
File dialog box. cod < .
mo Benge
# Navigate to the in: Range.
Iocatl?n of the flle dev i maros: [Gsmetics e 2] AW Decurnents C o
to be inserted (in s rf:r toots = [ st [8] | Cance
this case, the Module ; €
point

07 files in the Data
Files folder).

# Click the file named

— Idenies-access.tothe-individual §|

Creating a Newsletter with a Pull-Quote and Graphics

tab

1| Insert File
dialog box

| Insert button I

lumbet

¥Feate:

K

foft \ord D.. se—

Biometrics Article
to select the file
{Figure 7-34).

12)

# Click the Insert
button (Insert File
dialog box} to insert
the file, Biometrics
Article, in the
current document at
the location of the
insertion point.

+_ Raled
Origlan
Huigatian Pans

o

So that you can see s
the entire inserted
article, display
multiple pages

on the screen by
clicking the Multiple
Pages button (View
tab | Zoom group)
(Figure 7-35).

3]

= When you are
finished viewing the

cann ey

document, change

Figure 7-34

madt b betinr v - Wt
kil yau et §a o

b ] e bage

B D0 kduigh Pagn

T-} .-_;.:_. .-. I

Multiple Pages
button

2t Sectrar Ereah (Lo rlsd s )

the zoom to page
width so that the
newsletter content is
larger on the screen.

—————— x -

| Biametrics Article inserted—._V
and automatically formatted

in three columns — your

wordwrap and line or

columns breaks may differ

Figure 7-35




B
.—-} Creating a Newsletter with a Pull-Quote and Graphics Word Module 7 WD 401 =
3 4
. 3

B To Increase Column Width and Place |3 vonon s sace |3 ceane misvore (B
Z a Ve rtical Ru Ie between COIU mns 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER E
[ =
& The columns in the newsletter currently contain many rivers. Why? The justified alignment in the narrow o

columnn width often causes large gaps berween words. To eliminate some of the rivers, you increase the size of the =
5] columns slightly in this newsletter. In newsletters, you often see a vertical rule separating columns. Through the

Columns dialog box, you can change column width and add vertical rules. The following steps increase column
] widths and add vertical rules between columns.
‘___:l = Position the insertion point “fcdd or Remove |1 L TR T

somewhere in the feature article [ SM™™ Puten B ,
e - Home ]I'J-'i-:i e Haikngs Rewes Wiew W Tell mewhaly
B text. e '
— P-n" IE % 4= Breaks -+ Indent Spacing
. Dlsplay the Layout tab. 5 I:h - iDline Mumbers - 3= Left: 07 * 13 Before Opt N
et} jins Orientation  Size Columins ¥ Hyphenati P Sam . = 4
e » Click the 'Add or Remove v : Lo Ei mjrmiter R - e
Page 5§ T Paragraph [

Columns’ button {Layout tab | -

- =| One
. : P 5 1 . 1o Te « « 3 « «
) Page Setup group) to display the o> r‘/' i / Cotomns galry
MCS

Add or Remove Columns gallery q-l l

- Fi -36).
} (Figure 7-36} .
- =] L vices. verify- a secure- doors,: ¢
= ty. by-translating; =aftugre,. With.
Right . insertion .
— I of 1. point  print. read
= §.§ h!crchiumns,..w :'c‘)?\:rengzlc;jmm . than- $100,' <0
o a-fingerprint,-into-a-digital-code- small- business.
- that-is-compared- with-a-digital- fingerprint-read
- _..——rtqde- stored. in;bw M%
_‘} L. i - L
Figure 7-36

(2

'F} e Click More Columns in the Add
or Remove Columns gallery to

Columns

dialog box

[

. < Cel
'—) display the Columns dialog box. Sﬁﬂ elumns
12 —— T3 I
o If necessary, in the Wldth and = K i e Bevereen dhock
*-:; spacing area (Columns dialog = i box selected
" box), click the Width up arrow widthand ] @ One Two Thie Bight compares
until the Width box reads 2.1". spacing area |, Humber of columns: |3 5 [tine between] i .
D ¢ LA - l.’ n \Width and spacing ; Image' S
' < | How would | make the columns or- physical: | ¢ wian Spating: recogniti
© | different widths? ristic, such-as- L gL Cr g L access:

L
Q

You would remove the check mark
from the ‘Equal column width’

-a-digital-code- z enforce

Width up arrow

D check box and then set the o ‘E\::[l:r;nd‘:?‘:;'al‘}iqual column width ;YStemsr'
irfdividua! column widths in the chr:;:::tj:‘linct;%a?ll:’three Applyto: | This section - Start new coiumn ace:reco

:} diatog box. a1 21k | = | (e — public.- S
» Place a check mark in the Line - or- mobile- =TT T e s e T s e use-face-r

— between check box to select the - match- the. different-functions.for-different. unlock-

D check box {Figure 7-37). eristic. code,- fingers; -for-example,-one-finger-

,-:} obile-device- runs- a-program-and- a- different.

K ..

Figure 7-37

8 8
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3

¢ Click the OK button
to make the
columns slightly

" BiomEtricsq.l Section Braak {Continuous |

slightly wider columns
help to reduce rivers

“

wider and place a
line (vertical rule)

between each behaviora'. or- physical. personal. readers- ofi vmi‘m ““an- $100,- often: use. face. recognition. to-
column in the characteristic,, such-  as-  a. some. homs rules placed ; business- | protect-the.public.- Sorme-mobile.
document fingerprint,- into. a. digital- code. Users:  pL ?gf;::: ngerprint. devices. use- face- recagnition-
(Figure 7-38). that is compared. with. a- digital- readers- to- vermyromerrdentity- of. systems- to- uniock: the. device..

Biometric. devices verify. a ?:loors,-computers,-and-software.o‘ “rooms..  Law- enforcement:-
person’s |dentlty-by-translating-la- With- the- cost- of fingerprint- surveillance-systems, -and-airports.

code. stored- in- a- computer- or- users- before. they. can. access. a.
_____.—-—-_-———_'-‘-—.___

Face. recognition: pregrams. are-

Figure 7-38
| Other Ways
1. Double-click shaded space between 2. To adjust column widths, drag column 3. To insert single rule, click Borders arrow
columns eon ruler, enter settings (Columns boundaries on ruler {Home tab | Paragraph group)}

dialog box), click OK button

To Hyphenate a Document

2 FORMAT FIRST PAGE | 3 CREATE PULL-QUOTE

4 CREATE NAMEPLATE FOR SECOND PAGE 5 FORMAT SECOND PAGE ! & ADD PAGE BORDER

The following steps turn on the hyphenation feature. Why? To further eliminate sone of the rivers in the
colummns of the newsletter; you turn on Word’s hyphenation feature so that words with multiple syllables are hypbenated at
the end of lines instead of wrapped in their entivety to the next line.

e Click the Change Hyphenation
button (Layout tab | Page Setup
group) to display the Change

Hyphenation gallery (Figure 7-39).

What is the difference between
Automatic and Manual
hyphenation?

12

# Click Automatic in the Change
Hyphenation gallery to hyphenate
the document (Figure 7—-40).

What if | do not want a particular
word hyphenated?

| Layout tab b~
" FEER T AT : - ; Torack } f 3
re iy AR LR o [
:_'mc MRS (o0 EGITES] Change N A -"|I|Itr..:'-|l||||.|‘j::;
Hyphenation 2
Braaks Indi button
| Ling Mumbers - = F a

Selection

; . Hyphm-tiﬂmh St Right: § tifie Ep Bane
T A113AF
{ /‘ -— ] Automatic |7 . (. . _ [ K
command N s
set displays dialog
Fage Setup \ - box that allows !
araup . .] you to specify Section Break (Conbinygpus}
| E— '_'—"—-!—_ =" hyphenationrules ____ " ———d
| Change i Figure 7-39
Hyphenation | 9
| gallery

Biometric- devices. verify- a- per- With-the caet.offinaarprint read- and-airports-
son's-identity by translatingp-be- ers. ofter ;‘:‘:;::‘:':T foo,-some. | nitiontoprot
havioral- or- physical- personal: -ar indotument [ess. users mobile-devic
characteristic,. such. as- a- finger-4"] int- readers- to tion systems
print,- into- a- digital. code that-is j sers-before Face- recogni

compared- with. a. digital. code. o a uter..The becoming-
stored- in- a- computer- or- mobile- r-also-can-be set-upto-per- and-can.recog
device..If-the. digital- code.in- the. - dif- without their
computer-or-mobile- device- does- ferent. fingers;. for-example,-dge- | jewelry,-and.
not- match- the- personal- charac-/ finger-runs-a-program-and- a-dif
teristic. code,. the computer or. ferentfingershutsdownthecom- *Hand-Geo
mobile- device- denies. access. to. puter - External- fingerprint. read- Handgeome
the.individual §) ers-usually pluginto-a-USB-port 4 the-shape-an

‘—'—-.—_”_—W
Figure 7-40
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To Format a Character as a Drop Cap

The first character in the feature article in this newsletter; that is, the capital letter B, is formatted as a
drop cap. Why? To add interest to an article, you often see a drop cap, which is a capital letter whose font size is larger
than the rest of the characters in the paragraph. In Word, the drop cap can sink into the first few lines of text, or it
can extend into the left margin, which often is called a stick-up cap. In this newsletter, the paragraph text wraps
around the drop cap.
The following steps create a drop cap in the first paragraph of the feature article in the newsletter.

# Position the insertion point
somewhere in the first paragraph
of the feature article.

+ Display the Insert tab.

» Click the ‘Add a Drop Cap’ button
(Insert tab | Text group} to display
the Add a Drop Cap gallery
{Figure 7-41).

® Experiment

# Point to various commands in the
Add a Drop Cap gallery to see
a live preview of the drop cap
formats in the document,

(2

» Click Dropped in the Add a Drop
Cap gallery to format the first
letter in the paragraph containing
the insertion point {the B in
Biometric, in this case) as a drop
cap and wrap subsequent text in
the paragraph around the drop
cap (Figure 7-42),

< | What is the outline around the
g drop cap in the document?

When you format a letter as a
drop cap, Word places a frame
around it. A frame is a container
far text that allows you to
position the text anywhere on the
page. Word formats a frame for
the drop cap so that text wraps
around it. The frame also contains
a paragraph mark nonprinting
character to the right of the drop
cap, which may or may not be
visible on your screen.

Table Pictures Online Shapes

Tables Hiustrations
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{ayout

T sma
[—_|[: l—g I._‘ |‘lz’:a|r'tmrt

Pictures - 14 Screenshot

§"

A._ Dropped
B' . Drepped-w——mr{ command creates
Text adrop cap
-Blometrics{{ | fm 1,

. In margin ,.__._..;__.......

| = ' In margin

. . : F R Cap Opticrs.. command

B'omehi:;ns: ?}/er and-airpe= BrerCepOmmer oy e
son's-i{ point . Py-transiz -l

havioral- or. physical-

4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BOADER

e Number=  goy o 9‘_-.'D_rop.f.‘aph [ object "/Ql gallery
r & Footer =:=
s - -

I 2 FORMAT FIRST PAGE |3 CREATE PULL-QUOTE

Add a |
Drop Cap ‘

i Date & Time

Hcne

nitionto-protectthe-public. L%
mobile-devices.use-face-recogn
tionsystemstounlock thedevic

_Fase—=—s—ikian. progra _m_r“,x-l

Figure 7-41

pers letter formatted by-tra ns-

as a drop cap

lating—=a- oenavioral- or-
“physical. personal. characteristic,-

rprint,into-a-digital-

role oo £
text wraps tightly . .
¢| around drop cap_pmipared with-a-dig-

ital-code-stored-in-a-computer-or:
mobile-device.. If-the-digital .code-
in-the.computer-or-mobile-device-
does- not- match. the- personal-
characteristiccode, the.computer-
or-mobile-device-denies-access-to

the.individual .4}

ic.devices-grant-access:

Figure 7-42

With-the-cost-of fingerprint-
ers. often- less. than- $100,- 4
home- and- small- business- §
purchase- fingerprint- reade
verify-the-identity-of -users-be
they-can-access-a-.computer.
reader-also-can-be-set-up-to-
form- different- functions- for
ferent. fingers;- for- example,
finger-runs.a-program-and- 2
ferentfingershutsdownthe
puter.. External- fingerprint.
ers.usually-plug-into-a-USB-p{

Mobile.compute
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To Format the Drop Ea_p

The following step changes the font color of the drop cap.

o With the drop cap selected, display the Home tab and then change the font color of
the drop cap to ‘Orange, Accent 4, Darker 25%" (eighth color, fifth row) in Font Color
gallery (shown in Figure 7-1a at the beginning of this module).

< | What if my frame no longer is displayed?
g Click the drop cap to select it. Then, click the blue selection rectangle to display the frame.

| 2 FORMAT FIRST PAGE | 3 CREATE PULL-QUOTE

To Insert a Next Page Section Break 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SICOND PAGE | 6 ADD PAGE BORDER

The third column on the first page of the newsletter is not a continuation of the feature article. Why not?
The third columm, instead, contains several reader announcements. The feature article continues on the second page of the
newsletter (hown in Figure 7-1b at the beginning of this module). Thus, you must insert a next page section break, which
is a section break that also contains a page break, at the bottom of the second column so that the remainder of the
feature article moves to the second page. The following steps insert a next page section break in the second column.

Layout tab

@ “Insert Page and Section

Breaks’ button

= Position the insertion point at the

o - e,
[P motvirerm ) Mudrgn T Andea .d___;;‘_um" T

Y B
bateri 7 o oo L Tali i
location for the section break, in S E Hs«mh nten Spacg | insert Page i & -
this case, to the left of the Fin the e Conme P70 B0 w=——— andSection | greaun
o i E B | Page Tt - Breaks gallery | Pane
Face Recognition System heading. Fagriemm | 'FLL Markske pent bt abith eas pge s bt 4l |
ey 3 1rdthe nespage segnr ] [ 1 H K o . e U
. Display the LayOUt tab' - f__ﬂl(:ﬂ' i ::o“‘::::inﬁu—w..‘znn PR Mobile computers,-smar‘tphones,- be-expensive, theyoﬁ
i Page Setup | Gresk el Kega on ind mpst22n ma and. smartwatches. often. have. a. in- larger- companies.
o Click the ‘Insert Page and Section | group ~ j [11, [etiiorsi built-in-fingerprint reader.-Using- | workers"time-and.atte
pirste ted srieed tgact:

theirfingerprint, users-canunlock as-security. devices.-Co

Breaks’ button (Layout tab | Page _|_ anar agen ik i o i

terisl Sedtion lreaks

. uter-or-device, signinto . }
Setup group) to display the Insert - . e Next Page | IS il o o e S S en
d Secti Break 1] r e e e | command  fand- websites-via. their. students'identities..Da
Pa.ge and >ection Breaks gallery | Section R e U et instead- of entering-a- | ters. and- hospital. nu
(Figure 7-43). | Breaks area et i nene, | USEF-N@Me-and-password,-and-on | them-toidentify-paren
etry: sesnzaon iy frma et some- dev‘l ‘‘‘‘‘‘‘ - test: their- uptheirchildren. 4|
insertion ] % i

syste Bl Bendstocin blood-pr oint | @rerate.q]
syste 0 semenne i r/wi—p' | = Voice Verification-d

teme |1 "Pue =[Face-Recognition-Systemf]
i cnErasd wrd dalive ne

cesttmimbearipge  1O-determine whethera-personis-

A- voice verification- §
compare- a. person’s: |

« Fingerprint-keagery| a-legitimate-user,-a-face-recogni- with. their. stored- voic
I T T T T | Tl L T
@ Figure 7-43
= |n the Section Breaks area in the Faan Sciue

gallery, click Next Page to insert TR e

. . fingerprint-scanner,-captures-the-
a next page section break, which curves. and-indentations. of.one’s

positions the insertion point on fingerprint.. Organizations- use
the next page, fingerprint. readers. to- secure
doors,-computers,-and- software..-
= |f necessary, scroll to the bottom 1
of the first page so that you can
see the moved text (Figure 7-44).

bottom of second
column and entire
third column now
insertion point and are empty
remainder of article
moved to page 2

*[Face-RecognitionSystem{| = Signature Verification-Sys-

arming whether.a personis.. | _tam@

Figure 7-44
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The next step is to insert a jump-to line at the end of the second column, informing
reader where to look for the rest of the feature article. The following steps insert a

jump-to line at the end of the text in the second column on the first page of the newsletter.

@

@
©

©

Scroll to display the end of the text in the second column of the first page of the
newsletter and then position the insertion point to the left the paragraph mark that is
to the left of the section break notation.

Press the ENTER key twice to insert a blank line for the jJump-to text above the section
break notation.

Press the UP ARROW key to position the insertion point on the blank line. if the biank
line is formatted in the Heading 1 style, click the ‘Clear All Formatting’ button (Home
tab | Font group) so that the entered text follows the Normal styte.

Press CTRL+R to right align the paragraph mark. Press CTRL+I to turn on the italic
format. Type (Article continues on next page) asthejump-to textand
then press CTRL+I again to turn off the italic format.

f 2 FORMAT FIRST PAGE | 3 CREATE PULL-QUOTE

Word Module 7
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4 CREATE NAMEPLATE FOR SECOND PAGE | § FORMAT SECOND PAGE | 6 ADD PAGE RBORDER

To Insert a Column Break

In the Security Trends newsletters, for consistency, the reader announcements always begin at the top of the
third column. If you insert the Security Trends Announcements at the current location of the insertion point,
however, they will begin at the bottom of the second column. Why? The insertion point currently is at the bottom of

e 8

8 &

€ 8

S €8 @

@ 88

the

@

seconzd coluam.,

For the reader announcements to be displayed in the third column, you insert a column break at
the bottom of the second column, which places the insertion point at the top of the next column. Thus, the
following steps insert a column break at the bottom of the second column.

Layout tab

Position the insertion point to
the left of the paragraph mark
on the line containing the next
page section break, which is the
location where the column break

‘Insert Page

and Section

Breaks' button
.

fireaks
Page Sreaks

Insert Page
4 and Section
| Breaks gallery .

Jumng

= Fage

N M 3
sndt

Seleclion
Pane

Arrauge

H [ i

should be inserted. ute Cortmn -2 | e G ‘t-reaule;.-_uémg-
. nak i s It’ﬁ!T?ﬁ’l’Hg’éTpﬂﬁr,'-‘Jsers canunlock:
+ If necessary, display the Layout Fifl e i ——— iy J
tab. T jump-to text ke e 2o foeiy
. . “SYSTE = seceeneq CVErEd s B e e TR
s Click the ‘Insert Page and Section ]{ :::n I ‘;‘H(A,—ﬁcle.conﬁnues.on.next.pagem
e i ven 3 — - A
Breaks’ button (Layout tab | Page . | s I | formatting mark
S ) t d | th I 1 ’ -’:ﬁhc G point __'_———Dh] Section Break {fiext Page) -—— for next page
etup group) to display the Inser [ g 1 2 —I._, e i —_— | section break |
Page and Section Breaks gallery I P i
(Figure 7-45}. Figure 7-45

(2

Click Column in the Insert Page
and Section Breaks gallery to

With-the-cost jasertion point

- Sectigr Break (Next Page}

insert a column break at the
location of the insertion point
and move the insertion point to
the top of the next column
(Figure 7-486).

ers. often. les 2nd section break Ly’

moved to top of
home- and-: St third column s

purchase- fingerprint- readers. to
verify the-identity-of users-before

Figure 7-46
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< |What if | wanted to remove a column break?
g You would double-click it to select it and then dlick the Cut button {Home tab | Clipboard group) or press ine DELETE key.

% Other Ways

| 1. Press CTRL4SHIFTHENTER

To Insert a File in a Column of the Newsletter

So that you do not have to enter the entire third column of announcements in
the newsletter, the next step in the project is to insert the file named Security "Trends
Announcements in the third column of the newsletter. This file contains the three
announcements: the first about reader discounts, the second about an upcoming
webinar, and the third about the topic of the next newsletter issue.

The Security Trends Announcements file is located on the Data Files. Please
contact your instructor for information about accessing the Data Files. The following
steps insert a file in a column of the newsletter.

With the insertion point at the top of the third column, display the Insert tab.

Click the Object arrow {Insert tab | Text group) to display the Object menu and then
click ‘Text from File' on the Object menu to display the Insert File dialog box.

Navigate to the location of the file to be inserted {in this case, the Data Files folder).

Click Security Trends Announcements to select the file.

@00 60

Click the Insert button {Insert File dialog box) to insert the file, Security Trends
Announcements, in the document at the location of the insertion point.

What if text from the announcements column spills onto the second page of the
newsletter?

©

Press SHIFT+F5 to return the insertion point to the last editing location, in this case, the
top of the third column on the first page of the newsletter (Figure 7-47).

©

Save the newsletter again on the same storage location with the same file name.

nsertion
point . .

PeaderDiscounts'ﬂ

| file inserted in third
column of newsletter

iometric- devices- verify- a-
person'sidentity by trans-

With the-cost-of fingerprint-read-
ers- often- less- than- $100,- some.

lating- a- behavioral- or.
ysical- personal- characteristic,-
ch as-afingerprint,into-adigital-
ode that-is-compared-with-a-dig-
al-code.stored.in-a-computer-or-
obile device.-If-the-digital-code
the.computer-or-mobile-device
es: not- match. the personal
racteristiccode, the computer-
-mobile-device-denies-accessto-
e.individual 4]

home. and. small- business- users
purchase- fingerprint: readers. to
verifythe identity-of users.before.
they-can-access-a-computer.-The-
reader-2lso-can-be-set.up-to-per-
form- different- functions-for- dif-
ferent-fingers;- for- example,-one
finger:runs. a- program-and- a- dif-
ferentfingershutsdownthecom-
puter.- External-fingerprint- read-
ers-usual y-plug-into-? USB-port.q

Mobile.comseba———dabanag .

Figure 7-47

Enterthe name of ournewsletter,-

Security- Trends, when. shopping
online.or-mention-our newsletter
name-ta.local stores.to-receive a
10- percent: discount: on- regular

priced-products-atthese retailers:.
Broman. Electronics,- Henderson-

Office. World,. Super. Software

Warehouse,- and: Total. Security.

Systems.q|

« Free‘\Webinard)

Are. you. interested- in- learning.

Creating a Pul

I-Quote

A pull-quote is text pulled, or copied, from the text of the document and given
graphical emphasis so that it stands apart and commands the reader’s attention. The
newsletter in this project copies text from the first page of the newsletter and places it
in a pull-quote, also on the first page between the first and second columns (shown in
Figure 7-1a at the beginning of this module).
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Creating a Newsletter with a Pull-Quote and Graphics Word Module 7 WD 407

What guidelines should you follow when using pull-quotes?
Because of their bold emphasis, pull-quotes should be used sparingly in a newsletter. Pull-quotes are useful for breaking the
monotony of long columns of text. Typically, quotation marks are used only if you are quoting someone directly. If you use

quotation marks, use curly {or smart) quotation marks instead of straight quotation marks.

To create the pull-quote in this newsletter, follow this general procedure:

1. Create a text box, which is a container for text that allows you to position the text anywhere on the page.

2. Copy the text from the existing document to the Office Clipboard and then paste the text from the Office Clipboard to

the text box.

3. Resize and format the text box.

4. Move the text box to the desired location.

To insert a Text Box

4 CREATE MAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE ] 6 ADD PAGE BORDER

CONSIDER THIS %

! 3 CREATE PULL-QUQTE

The first step in creating the pull-quote is to insert a text box. A text hox is like a frame; the difference is
that a text box has more graphical formatting options than does a frame. The following steps insert a built-in

text box. Why? Word provides a variety of built-in text boxes, saving you the time of formatting the text box.

1

# Click the 'Choose a Text Box'
button {Insert tab | Text group)
to display the Choose a Text Box

gallery.

[ f_J 1 .
W/ Experiment
= Scroll through the Choose a Text

Box gallery to see the variety of
available text box styles.

» Scroll to display Simple Quote
in the Choose a Text Box gallery
(Figure 7-48).

2

s Click Simple Quote in the Choose
a Text Box gallery to insert that

style of text box in the document,

» |f necessary, drag the text box to
the approximate location shown
in Figure 7-49,

-
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ﬁ ] EJ Quick Parts = 2 Signature tine -
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Beox' button

T Equation +
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Box gallery
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« | Does my text box need to be in the exact same location as in Figure 7-497
¢! No. You will move the text box later.

The layout of the first page is not correct because of the text box. What do 1 do?

You will enter text in the text box and then position it in the correct location. At that time, the layout of the first
page will be fixed,

1 Other Ways

1. Click ‘Explore Quick Parts’ button {Insert tab | Text group), click ‘Building Blocks Organizer’ on Explore Quick Parts menu, select desired text box
name in Building blocks list, click Insert button

H 1 ¥ €REATE PULL-QUOTE

To Split the Wi ndow 4 CREATE NAMEPLATE FOR SECOND PAGE | 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

The text that you will copy for the pull-quote is in the middle of the first page on the newsletter and the
puli-quote (text box) is near the top of the first page of the newsletter. Thus, the next step is to copy the pull-
quote text from the middie of the first page and then paste it in the pull-quote at the top of the first page. You
would like to view the pull-quote and the text to be copied on the screen at the same time. Why? Viewing both
simultaneously will simplify the copying and pasting process.

Word allows you to split the window in two separate panes, each containing the current document and
having its own scroll bar. This enables you to scroll to and view two different portions of the same document at
the same time. The following step splits the Word window.

1)

= Display the View tab.

» Click the Split Window button (View tab | Window group) to divide the document window in two separate
panes — both the upper and lower panes display the current document (Figure 7-50).

| .:u-f'.le.'ﬂ' Tosrh Himsiletiod sots 'H- face of Split f

LRSS Window

e o I - ] button displays
=115 E .'Tomr" 'h.m ’:" pud '..0“.'* = E |_| — text, Remove
& e = LU Gridknes T 1o, DMubplebages R split, when
2 Layout Leyout Harigwas Fane ToPageVrdth  whndow an  Split window is split
| Witwk Show Laam Windze
- - - . Window /
-Bilometrics§— group
I iometric-devices-ver- Grabvourreaders-attention-with:

r ify-a-person’sidentity- S h fr et B e

[ Reecpans I' =1 by- translating- a-be- = = s : Al
havioral-or-physical-personal- AR, e ;
characteristic,- such-as. a-fin- I NG [

split bar — yours gerprint,. into. a. digital- code- ;

may be in a different = = = AT <t g = 5 L T

ot SRS T A s e et it b b4t A s+ 3

e that-is-compared-with-a.digi- i
talcode storedinacomputer- : |
or-mabile.device -If-the-digi- hR A l

o e gl - .. . - v - . "

|—lower ) I B i with-the.cost-of fingerprint-read-

e k) I moblIedewcedoes.-nc?t-matchothe- ers. often- less. than- $100,- some. | 59
personal-characteristic- code, - the- TP e T ey ey 3
computeror-rrlol?aI.edevacedenles- purchase- fingerprint. readers. to- | ;
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Figure 7-50
Other Ways

1. Press ALTH+CTRL+S
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To ARRANGE ALL OpPEN WoORD DOCUMENTS ON THE SCREEN

Creating a Newsletter with a Pull-Quote and Graphics Word Module 7 WD 409

If you have multiple Word documents open and want to view all of them at the
same time on the screen, you can instruct Word to arrange all the open documents on
the screen from top to bottom. If you wanted to arrange all open Word documents on
the same screen, you would perform the following steps.

1. Click the Arrange All button (View tab | Window group) to display each open

Word document on the screen.

2. To make one of the arranged documents fill the entire screen again, maximize
the window by clicking its Maximize button or double-clicking its title bar.

To Copy and Paste Using Split Windows

| 3 cREATE PULL-QUOTE

4 CREATE NAMEPLATE FOR SECOND PAGE | 3 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

The following steps copy text from the middle of the first page of the newsletter to the Clipboard (the
source) and then paste the text into the text box (the destination) at the top of the newsletter. Why? The item
being copied is called the source. The location to which you are pasting is called the destination.

o

¢ In the upper pane, scroll so that
all placeholder text in the text box
is visible, as shown in Figure 7-51,

# In the lower pane, scroll to display
the text to be copied, as shown
in Figure 7-51, and then select
the text to be copied: Biometric
devices grant access to programs,
mobile devices, computers, or
rooms using computer analysis of
some personal characteristic.

* Display the Home tab.

# Click the Copy button (Home
tab | Clipboard group) to copy
the selected text to the Clipboard
(Figure 7-51).

2]

* In the upper pane, if necessary,
scroll to display the text in the
text box. Click the text in the

i B = pasted text
text box to select it. Puste G-%-A- SEl=EE 2 oo - | ttoms | MomR WG T—Rad
. F. Options: s P raph Iy
* Click the Paste arrow (Home o) e e o e e . .
5 A

tab | Clipboard group) to display
the Paste menu,

L

L)

Ppuie Special

< What if | click the Paste Merge

g button by mistake?

button

Formatting

Click the Paste Options
button to the right of the pasted

text in the text box to display
the Paste Qptions menu b

L

* Point to the Merge Formatting
button on the Paste menu and
notice the text box shows a live
preview of the selected paste
option (Figure 7-52).
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g Why select the Merge Formatting button on the Paste menu?

Q

©

» Click the Merge Formatting button on the Paste menu to paste the copied text into the text box.

< | Why does a hyphen appear in the source?
°°d, Word may have hyphenated the word automatically. You will format the pull-gquote text next.
Other Ways
1. Click copy on shortcut menu (or, if using touch, tap Copy on mini 2. Select text to copy, press CTRL+C; select destination for pasted text,
toolbar), right-click where item is to be pasted, click "Keep Source press CTRL+Y
Farmatting' in Paste Options area on shortcut menu (or, if using
touch, tap Paste on mini toclbar}
To Remove a Split Window
The next step is to remove the split window so that you can position the pull-
quote. The following step removes a split window.

o Double-click the split bar {shown in Figure 7-52), or click the Split Window button
again (View tab | Window group), or press ALT+SHIFT+C, to remove the split window
and return to a single Word window on the screen.

To Format Text in the Text Box

n— The next steps format text in the pull-quote.

Rotating Text Box
Text

To rotate text in a text box,
select the text box, click
the Text Direction button
{Drawing Tools Format tab |
Text group), and then click
the desired direction on the
Text Direction menu.

0 If necessary, scroll to display the text box in the document window.

select all the text in the text box, change its font to Century Schoolbook (or a similar
font), bold the text, and change its font size to 11 point. If necessary, center this
paragraph.

Click in the text box to deselect the text, but leave the text box selected {(shown in
Figure 7-53).

To Re;ize a Text Box

The next step in formatting the pull-quote is to resize the text box. You resize a
text box the same way as any other object. That is, you drag its sizing handles or enter
values in the height and width boxes through the Size button (Drawing Tools Format

tab | Size group). The following steps resize the text box and insert line break characters.

o Drag the sizing handles so that the pull-quote looks about the same size as Figure 7-53.

a Verify the pull-quote dimensions in the Shape Height and Shape Width boxes
(Drawing Tools Format tab | Size group) and, if necessary, change the value in the
Shape Height box to 1.75 and the Shape Width box to 2.08.

g What if some of the words in the text box are hyphenated?
o

T T ] S
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Drawing Tools
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Figure 7-53

To Apply a Shape Style to a Text Box

The next step in formatting the pull-quote is to apply a shape style to the text
box to coordinate its colors with the rest of the newsletter. The following steps apply a
shape style to a text box.

@ With the text box still selected, click the More button (shown in Figure 7-53) in the Shape
Styles gallery {Drawing Tools Format tab | Shape Styles group) to expand the gallery.

9 Point to ‘Colored Fill - Orange, Accent 4' (fifth style, second row) in the Shape Styles
gallery to display a live preview of that style applied to the text box (Figure 7-54).

e Click "Colored Fill - Orange, Accent 4' in the Shape Styles gallery to apply the selected
style to the shape.
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Figure 7-54

M_osition a Text g_ox

The following steps move the text box to the desired location in the newsletter.

o With the text box still selected, drag the text box to its new location (Figure 7-55).
You may need to drag and/or resize the text box a couple of times so that it looks
similar to this figure,

Enterthename.of ournews|etter,-
, when. shopping:
on-our-newsletter
name-toJocal-stores-to-receive.a

10 percent- discount. on reaular.

BTW

Text Box Styles

Like other drawing objects

or pictures, text boxes can

be formatted or have styles
applied. You can change the
fill in a text box by clicking
the Shape Fill button or
arrow (Drawing Tools Format
tab | Shape Styles group),
add an outline to & text box
by clicking the Shape Outline
button or arrow (Drawing
Tools Format tab | Shape
Styles group), and apply an
effect, such as shadow or 3-D
efiects, by clicking the Shape
Effects button {Drawing Tools
Format tab | Shape Styles
aroup).

Word Module 7
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BTW

Moving Text Boxes
To move a text box using
the keyboard, select the
text box and then press the

arrow keys on the keyboard.

For example, each time you
press the down arrow key,
the selected text box moves
down one line.
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Figure 7-55

9 Click outside the text box to remove the selection,

Why does my text wrap differently around the text box?

If the jump-to line, which is supposed to appear at the bottom of the second column
(shown in Figure 7-56), moved to the top of the third column, position the insertion
point in the article title (Biometrics) and decrease the spacing before and after (Layout
tab) until the jump-to line moves back to the bottom of the second column.

o Save the newsletter again on the same storage location with the same file name.

Break Point: If you wish to take a break, this is a good place to do so. You can exit Word now. To resume at a later time, run Word,
open the file called Security Trends Newsletter, and continue following the steps from this location forward.

Formatting the Second Page of the Newsletter

The second page of the newsletter (shown in Figure 7-1b at the beginning of this
module) continues the feature article that began in the first two columns on the first
page. The nameplate on the second page is less elaborate than the one on the first

page of the newsletter. In addition to the text in the feature article, page two contains a
graphic. The following sections format the second page of the newsletter in this project.

How do you create a nameplate for inner pages of a newsletter?
The top of the inner pages of a newsletter may or may not have a nameplate. If you choose to create one for your inner pages,
it should not be the same as, or compete with, the one on the first page. Inner page nameplates usually contain only a portion
of the nameplate from the first page of a newsletter,

=
I
=
"
w
a
Vi
=
Q
U

To Change Column Formatting

4 CREATE NAMEPLATE FOR SECOND PAGE = 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

The document currently is formatted in three columns. The nameplate at the top of the second page,
however, should be in a single columnn. Why? The nameplate should span across the top of the three columns below it.
The next step, then, is to change the number of columns at the top of the second page from three to one.
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As discussed earlier in this project, Word requires a new section each time you change the number of
columns in a document. Thus, you first must insert a continuous section break and then format the section to
one column so that the nameplate can be entered on the second page of the newsletter. The following steps
insert a continuous section break and then change the column format.

©

» If you have a blank page between
the first and second pages of
the newsletter, position the

‘Insert Page and
Section Breaks'
button

At o F,
e, li Indent Spacing =iy
aaks = 2pt N ’ ==

insertion point to the left of the e e Insert Page Sdction
Ll o oint b S and Section e
pa-ragraph mark at th‘e end of the e Byt LUFTUy baahepcon i ebich coe pugecats .| Breaksgallery [T .
third column on the first page l LT some- devices,- even. test. their-
inr Indicate that the test Scllening the column
of the newsletter and thfen press =z ﬁup : Ereah vl begin the et celuma blood-pressure and-heart rate 4]
the DELETE key as many times as group P Text Wrapping ) .
necessary to delete the blank line Tinge sy, (Articlecontinues-on-next page){]
+ H lon Rreaks
causing the overflow. Sicord pagh A . S
» Position the insertion point at the D ohea here Ty ety etk i st
sItlone . secticnenthe netpags
upper-left corner of the second T Continugus =+ Continuous jump-to line and column
Incent 4 sactian Erese and stazt the new command formatting mark at end
page of the newsletter (to the left ¥ “I T secticn eathe ssme page. of second column
i | B Even P
Df F n Face)' L : L..;:,:-! Im:ﬂ.ul:')::‘.mnb.'e:'-:andmnlheum
| h b F = section ¢n the nta e gn-rumbered gige.
= Display the Layout tab. S0 o
. . }:_-:\:,i Inzert :9:““" Brevi and ttait the nga
. Cllck the ‘Insert Page and Section '“ "_—-"l secticn onthe et ad loumbered page.
Breaks' button (Layout tab | Page s Face-Recognition-Systemf] J Slgnature Verification Sys
Setup group) to display the Insert m:enm p;m “~eminge whethera persopis—— —
Page and Section Breaks gallery at top of page 2 Figure 7-56

(Figure 7-56).

‘Add or Remove
Columns’ button [

)

# Click Continuous in the Insert Mg Questaon s-=' Colx
Page and Section Breaks galleryto__ |
insert a continuous section break | Page Sep '-"‘".’

: - . greup
above the insertion point. e :

—| = 8reats - Indent
|Dl§nt“umbeli' Sl 8 : 12Bedore 2pt : F
. ) E . T = Selection
a! H,phenation - ¢ Right I taAler Opt = g
Patsgraph . susege
1 i S . 3 ' ' ¥

current section that - devices,- even- test: their- \

I_,!;‘ g [[H] _:_

i
R

o
H

i

t&ader| will contain second
vader 3| pooe namepiate d.pressure and heart rate 4]
Taree i [:-8] thould be one column

nner‘.cmg.—l-—.—‘nfde-contmues -on-nextpageM}

Add or Remove Columa Break
Columns gallery

Do
:

# Press the Up ARROW key to position
the insertion point to the left of
the continuous section break just
inserted.

2 eam -—

Tizre Colymaz .

» Click the ‘Add or Remove
Columns’ button (Layout tab |
Page Setup group) to display the i iicrtr::ralbriena:rst
Add or Remove Columns gallery | of e
(Figure 7-57).

:‘los;r:ion —— ""I - sSect:on Break (Continvous),
l . Face.Recognition.Syst;ﬁmﬂ L] SignatuFE'Veriﬁcatlon'SYS'
I d&emgw—“ em T

e Figure 7-57

# Click One in the Add or Remove Columns gallery to format the current section to one column, which now is ready
for the second page nameplate.

» If necessary, scroll to display the bottom of the first page and the top of the second page, so that you can see the
varying columns in the newsletter (Figure 7-58).

:g Can | change the column format of existing text?
o

=
A
=
=
=]
=
=
=
=
=
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TG SEUP —
1)

e é! ..... 1o v e 1
I
= Fingerprint-Reaclerf]
| Afingerprint-reader, -also-called-a-
fingerprint scanner,-captures-the-

e e T o= TR

some- devices,: even. test- their.

blood pressure-and heart-rate.§|

{Article-continues.on next-page)¥}

e s e
—_—— 2 I anange .. R Sy

1 ' i FT
cookies,- phishing,- spyware. and-
adware,- electronic. profiles,. and-
social-engineering.q|

\ newsletter text are
in second section —

three columns of
. Columateak......
your section breaks
may appear in
different locations
insertion
point is section break formatted i
in third | to one column, which |
section | now extends from the left i
L \ margin to the right margin (
e N /
fourth section ; Section Break {Castinuous)

remains
formatted to
| three columns

FaceRecognition-System®
To-determine-whether-a personis.
a-legitimate-user,.a face recogni-

e

= Signature Verification Sys-
ternf]

A signature- verification- system.
recnonizes. tha chana. of vour.

Figure 7-58

Users.canforget-theirusernames.
and. passwords . Badges, - identifi-
cation<ards,-andkeyscan-belost,-
copied, duplicated, orstolen. Per- 1
st

e

To Set Custom Tab Stops Using the Tabs Dialog Box

The nameplate on the second page of the newsletter contains the text, Monthly
Newsletter, at the left margin, the newsletter title in the center, and the issue number
at the right margin (shown in Figure 7-1a at the beginning of this module). To
properly align the text in the center and at the right margin, you will set custom tab
stops at these locations. The following steps set custom tab stops.

Press the ENTER key twice and then position the insertion point on the first line of

ERRGTRELERE Clear All Formatting’ i
ELESEREE button "g.
i, e I e

N Paragraph e

Settings
Dialog Box

2

CotteliBes) - 1« A A7 A~

- - A, -

B I U =3 x, X

£
I.xt ' Format Painter

Launcher

gl ool 5 Fakt

Font group !
erprii uthel Tabs

Afingerprint.-reat i stop postion:

custom tab stops t-scann, :-5.-- s
set at these -——-—*{:'-

05"

Dafsult tab steps: i |

custom tab stops

L — —

| T steprtobedesred) Center and
locations i Right option
I buttons
| — S— N
Alignment
Quen Ofaren @ pgnt Q
i O Deamal Ogn 'L
T | Leader
Set 2 | area
button @ 1 Hone Q2 Ol | st
line being i
formatted with L‘—Tl}—l Oar dearzn

| QK I Carael 9
_| O bution I .

some-financial-

» Face-Recognition-Systemd]
To-determine whetheraperson-is. verification-syst
L.w.-———mﬁ_ fr--—»J (6)

e i

Figure 7-59

the second page of the newsletter, which is the paragraph to be formatted with the
custom tab stops.

Display the Home tab and then click the
‘Clear All Formatting' button (Home tab |
Font group) to apply the Normal style to
the first line on the second page of the
newsletter.

Click the Paragraph Settings Dialog Box
Launcher (Home tab | Paragraph group) to
display the Paragraph dialog box and then
click the Tabs button (Paragraph dialog box}
to display the Tabs dialog box.

Type 3.5 inthe Tab stop position text box
{Tabs dialog box), click Center in the Alignment
area to specify the tab stop alignment, and then
click the Set button to set the custom tab stop.

Type 7 inthe Tab stop position text box
(Tabs dialog box), click Right in the Alignment
area to specify the tab stop alignment, and
then click the Set button to set the custom
tab stop (Figure 7-59).

Click the OK button to set custom tab stops
using the specified alignments.
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To Format and Enter Text and Add a Border

The following steps enter the newsletter title at the top of the second page in the
third section.

o With the insertion point on the first line of the second page of the newsletter, click
the Font Color arrow and then change the font color of the current text to Teal,
Accent 5, Darker 50% (ninth column, bottom row). Change the font to Century

BTW

Leader Characters
Leader characters, such as
a series of dots, often are

used in a table of contents to | :

precede page numbers. Four
types of leader characters,
which Word places in the
space occupied by a tab

i character, are available FiEs)

Schoolbook (or a similar font) and then type Monthly Newsletter at the left in the Leader area of the b ok
margin. Tabs dialog box (shown in e
. . Figure 7-59). s
If requested by your instructor, enter your name instead of the word, Monthly. e Ty

Press the 7aB key to advance the insertion point to the centered tab stop. Increase the
font size to 14 point and then click the Bold button {Home tab | Font group) to bold
the text. Type Security Trends atthe centered tab stop.

Press the TAB key to advance the insertion point to the right-aligned tab stop. Reduce
the font size to 11 point and then dick the Bold button (Home tab | Font group) to
turn off the bold format. Type Issue 15 at the right-aligned tab stop.

© O O

Click the Borders button (Home tab | Paragraph group) to add a bottom border
{shown in Figure 7-60).

Why is the border formatted already?
When you define a custom horder, Word uses that custom border the next time you
click the Borders button in the Borders gallery.

<
]
o

The second page of the feature article on the second page of this newsletter
begins with 2 jump-from line (the continued message) immediately below the
nameplate. The next steps enter the jump-from line.

o Position the insertion point on the blank line above the heading, Face Recognition
System, to the left of the paragraph mark.

Click the ‘Clear All Formatting’ button (Home tab | Font group) to apply the Normal
style to the location of the insertion point.

Press CTRL+I to turn on the italic format.

Type (Continued from £first page) andthen press CTRL+I to turn off the
italic format (Figure 7-60).

o0 O

nameplate on
second page

entered T
Monthly Newsletter - Security ' Trends - /

border added

i{ nameplate on
Issue 159

second page
entered

(Continued-fromfirst-pag

Section Break (i

hone- banking. transactions,- l isread-by-afingerprintreaderthat.
ome-financial-seryices. use-voice- is- linked- to-a- pavm

jump-from
text entered

Figure 7-60
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To Balance Columns

§ ¢

| & FORMAT SECOND PAGE | 6 ADID PAGE BORDER

space. Why? Typically, the text in cohummns of a newsletter is balanced. To balance columns, you insert a continuous

Currently, the text on the second page of the newsletter completely fills up the first and second columns
and almost fills the third column. The text in the three columns should consume the same amount of vertical

section break at the end of the text. The following steps balance columns.

@

o Scroll to the bottom of the text in the third column on the second page of the newsletter and then position the
insertion point at the end of the text.

If an extra
paragraph
mark is below

the last line of

text, press the
DELETE key to

remove the extra

paragraph ma

Display the Layout

tab.

rk.

Click the ‘Insert
Page and Section
Breaks' button

{Layout tab |

Page Setup group)

to display the
Insert Page
and Section
Breaks gallery
{Figure 7-61).

@

# Click Continuous
in the Insert Page

and Section Breaks

gallery to insert

a continuous
section break,

which balances the

columns on the
second page of
the newsletter

(Figure 7-62).

Save the newsletter
again on the same

storage location

with the same file

name.

'Insert Page and Section
Breaks' button

Refarences

Indent Spackng

Eage
Niark the goirt at which one page ends
and the next page Segne.

. goumn
e Indic ate that the test foll wag the column

breay: =4 bagin in the nest celumn,

i Text Wrapping
d-t Separate text wrcund ebyects o web
h -1 pages, such 35 captisn tot from body fed
I
Section Breaks
e Hext Page
A Ingen 3 sectcn breal and start the nesr

Liatings Revane

% Gpt

o ket i ,
tablet .Signature-verification-sys- |

St.(i::ri
B8 Insert Page
and Section
Breaks pallery |

Views L0 ¢

3pt

tems: often: are. used- to- reduce
fraud.infinancialinstitutions.q|

» |ris-Recognition-System$
High-security. areas-often-use.iris

1 tems.-The.camera-

Continuous

£ e .
n ection on tise next page
. cont i
it Insest + secten break and startthe new
« - seguen 3a the rame page.
2 Even Page
C =3 Ingert  section brask and 1Ly The neie
T sacticn o the nest e.en-numtersd page

1 L!_ Qgd Page
3 Ingert 4 $ection Dregk and stadt tre i
=1 gecten onshe rat cddinunitecad s1ge

ecurity-devices.. Colleges-use- |
-geometry-systems-to-verify-
dents’identities.-Daycare.cen-
5. and- hospital- nurseries. use.
emto.identify parents-who-pick

T

command

n- technology- to

read patternsintheirisofthe eye -
These.patterns-are-as-unique-as-a:

fingerprint.. Iris. recognition. sys-

tems are-quite-expensive and are-

used-by financial-institutions.that

deal- with. highly- sensitive- data,-

government. security organiza-
tions, -and-the military.-Some:or-
ganizations-use:retinal scanners,

: Use-these's

be-expensive, they-.often-are-used.
in- larger. companies- to- track
workers'.time-and-attendance.or

as-security-devices.- Colleges-use-

hand-geometry-systems-to-verify-
students’.identities..Daycare.cen-
ters- and- hospital- nurseries. use-
themtoidentify parents-who-pick-
uptheirchildren.§ I

» Vaice Verification-System{]
A. voice- verification. system. will-
compare. a- person’s- live- speech.
with. their. stored- voice. pattern

I'n

Figure 7-61

«[ris:Recognition-System§

nition-system-uses.

1
—

have some-disadvantages.-[f-you

cut. your- finger, a. fingerprint-

reader mightreject-you-as-alegit-
imate-user,-Hand-geometry.read-

ers-cantransmit.germs.-if-you-are-
nervous,- a- signature- might- not.
match-the one-on file.if you-have-
a-sore-throat, .a-voice.recognition-
systermn. might- reject. you.. Many-
people are. uncomfortable. with.

using.an iris-or-retinal- scanner |1]

"

insertion
point

| alsmns not
| balanced J

fgue-and-cannot-be-forgot-

High-security-areas-often-use-iris-

recognition-systems.-The-camera
in-an iris-recognition-system-uses

iris. recognition. technology. to-

readpatternsintheirisofthe-eye.

These patterns-are asunique-as-a.

fingerprint.- Iris- recogniticn- sys-
temns-are quite-expensive-and-are

used by financialinstitutions-that-
deal- with: highly. sensitive: data,-

government- security- organiza-
tions, and-the-military.-Some-or-
ganizations use- retinal- scanners,

- )
columns .
balanced

Figure 7-62

ten-or-misplaced §

Biometric- devices,- however,- do-
have.some. disadvantages.-If-you-
cut: your- finger,- a- fingerprint:

reader-mightreject-you-asa-legit-
imate.user..Hand geometry-read-

ers can-transmit germs. If you-are-
nervous,- a- signature- might- not-
match-the-one-onfile.-If you-have.
a-sore-throat,-a-voice recognition:
system- might: reject. you.. Many-
pecple. are uncomfortable. with-
| using-an-ris-or retinal-scanner.
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Modifying and Formatting a SmartArt Graphic

Recall from Module 4 that Microsoft Office includes SmartArt graphics, which
are visual representations of ideas. Many different types of SmartArt graphics are
available, allowing you to choose one that illustrates your message best.

In this newsletter, a SmartArt graphic is positioned on the second page, at the
top of the second column. Because the columns are small in the newsletter, it is best
to work with a SmartArt graphic in a separate document window so that you easily
can see all of its components. When finished editing the graphic, you can copy and
paste it in the newsletter. You will follow these steps for the SmartArt graphic in this
newsletter:

1. Open the document that contains the SmartArt graphic for the newsletter,
. Modify the layout of the graphic.

Add a shape and text to the graphic.

Format a shape and the graphic.

Copy and paste the graphic in the newsletter.

A

Resize the graphic and position it in the desired location.

To Open a Document from Word

‘The first draft of the SmartArt graphic is in a file called Biometrics Diagram on
the Dara Iiles. Please contact your instructor for information about accessing the Data

Files. The following steps open the Biometrics Diagram file. =
= SmartArt Yook tab

| file containing SmartArt + contains Design
@ Navigate to the location of the | grephic opened [ | and Format tabs

= T
Hemrtrics Dagam aid

Data Files on your hard drive,
OnebDrive, or other storage

Anleranres | Ba i

location. : s AW R St AU 0 (aancen aaBbCcDc AGBDC: Saistel A
i e L] “Hasmal | THoSpac.. Headingl  Heading 2
9 Open the file named Biometrics . : b % e c _ styes
Diagram on the Data Files. ' ' o it
9 Click the graphic to selectitand | ‘ i ) ;’r‘l?m“
display the SmartArt Tools Design i o / selected
and Format tabs (Figure 7-63). .(..:-_- u\. 3'\1
< | Is the Security Trends Newsletter "«}f-?l P ST )
f’-jrifiie still open? Q@ [t O
| Yes. Leave it open because yvou I
: ill copy the modified diagram
i‘;if the second page of the :
I newsletter
b
F#F._'___._.-r-—“""“—"-—._,_\___“_‘_-_- L o _‘_"H"'—-_ ,_,,_.--""-"-'_-'_._-_—‘
Figure 7-63
. | :
To Change the Layout of a SmartArt Graphic I's foRmar stcomd Pace | 6 ADD pAGE bomDER

The following step changes the layout of an existing SmartArt graphic. Why? The SmartArt graphic

curvently uses the Radial Cycle layout, and this newsletter uses the Basic Radial layout.

P~
£ %
=3
T
[+]
=
=]
E Y
2
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o Smartart Tools
Design tab

» If necessary, display

Basic Radial
the SmartArt Tools e O e e evt

Design tab.

%y o3 ofe 43
e o eve @ 79
# Scroll through Smarthit s ' '

the layouts in the TR LR e e
Layouts gallery : ;
until Basic Radial
appears, if necessary,
and then click Basic
Radial to change
the layout of the
SmartArt graphic
(Figure 7-64).

Figure 7-64
Other Ways

1. Right-click the selected graphic, click Layout button on mini toolbar and select desired layout, or click Change Layout on shortcut menu, select
desired layout, click OK button

To Add a Shape to a SmartArt Graphic

The current SmartArt graphic has five perimeter shapes. This newsletter has a
sixth shape. The following step adds a shape to a SmartArt graphic.

SmartArt Tools
Design tab

Add Shape
button

0 With the diagram selected,
’ ottt _ : click the Add Shape button
4 S o 5 Derigr M Loyt 58 Rk S W K B B =l £19 1ok i {SmartArt Tools Design tab |
gm“‘: e ) Create Graphic group) to add a
fTetPane & Rghttaleft 7 Lain shape to the SmartArt graphic
(Figure 7-65).

Create Graghic

< | Why did my screen display

¢ a menu instead of adding a
shape?
You clicked the Add Shape
arrow instead of the Add
Shape button, Clicking the Add
Shape button adds the shape
automatically; dicking the Add
Shape arrow displays a menu
allowing you to specify the
location of the shape.

| ¢reate Graphic
.| group

= shape added
£ and selected

How do | delete a shape?
Sefect the shape by clicking

it and then press the DELETE
i key, or right-click the shape
Figure 7-65 and then click Cut on the mini
toolbar or shortcut menu.

-
L
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To Add Text to a SmartArt Graphic | :
th rough the Text Pane |5 FORMAT SECOND PAGE 6 ADD PAGE BORODER

In Module 4, you added text directly to the shapes in a SmartArt graphic. In this project, you enter the text
through the Text Pane. Why? Some users prefer to enter text in the Text Pane instead of in the shape. The following
steps use the Text Pane to add text to a shape.

e Click the Text Pane control, which
is on the left side of the SmartArt

Word Module 7

SmartArt Tools |
Design tab

H i LIAd] Shape - & Pmctt : r.| = . e & 2 T O — —
graphic, to display the Text Palj\e to E]u-aun:: e e Up : % 58 o) R : 3
the left of the SmartArt graphic. Diare] 2 sgot = § il K A R g

Create Graphic - _c":"f’"'fml o b
group P

iy O
¢ In the Text Pane, if necessary, ‘m =
position the insertion point to the ' B'“_"',‘i:.';'r:f:l"‘"’ }
right of the bullet that has no text e face image
to its right. E‘_'_"‘“e ~T P:w:“":n‘ i Ig::tt r":lﬂe
¢ Type iris or retina asthe " pondon e
text for the shape (Figure 7-66). = it er reting] {;J
¢ Click the Close button in the Text T . y0uttyr:e text in _TexltI
e, text a atica -
Pane to close the Text Pane. a;:ea,s ™ SmartArt g,:phic Figure 7-66
§ Can | instead close the Text Pane by clicking the Text Pane button (SmartArt Tools Design tab | Create Graphic group)?
Yes,
o

o Save the file containing the SmartArt graphic with a new file name on your hard drive, OneDrive, or other storage
location using Biometrics Diagram Modified as the file name.

1 Other Ways

f 1. Click Text Pane button (SmartArt Tools Design tab | Create Graphic group)

To Format SmartArt Graphic Text

BTW
"Io format text in an entire SmartArt graphic, select the graphic and then apply Demoting Text Pane
the format. The following steps bold the text in the SmartArt graphic. Text

Instead of pressing the Tag
) ) . key in the Text Pane, you
o If necessary, click the shape just added to select it. could click the Demote

) . Selection button (SmartArt
9 Display the Home tab. Click the Bold button {Home tab | Font group) to bold the text Tools Design tab | Create

in the SmartArt graphic (shown in Figure 7-67), Graphic group) to increase
{or move to the right) the

' ' indent for a bulleted item
To Mobiry THEME EFFECTS You also can click the

Promote Selection button
{SmartAnt Tools Design tab

If you wanted to change the look of graphics, such as SmartArt graphics, you

would perform the following steps to change the theme effects, Create Graphic group) to
. . I : decrease (or move to the
1. Click the Thelzme Effect% button (Design tab | Document Formatting group). leF) the Frdent for & bulketed
2. Click the desired effect in the Theme Effects gallery. item.

To Save Customizep THEMES

When you modify the theme effects, theme colors, or theme fonts, you can save
the modified theme for future use. If you wanted to save a customized theme, you
would perform the following steps.

1. Click the Themes button (Design tab | Document Formatting group) to display
the Themes gallery.
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BTW 2. Click ‘Save Current Theme’ in the Themes gallery.
Ciipboard Task Pane

and fcon

You can control when the
Clipboard task pane appears
on the Word screen and

the Qffice Clipboard icon
appears in the notification
area on the taskbar. To

do this, first display the
Clipboard task pane by
clicking the Clipboard Dialog
Box Launcher on the Home
tab Mext, click the Options
button at the bottom of the . )
Clipboard task pane and then 1. Items are copied fiom a source document. If the source document is not the
click the desired option on active document, display it in the document window.

the menu. For example, if . .

you want 1o be able to open 2. Open the Office Clipboard task pane and then copy items from the source
the Clipboard task pane by document to the Office Clipboard.

clicking the Office Clipboard
icon on the Windows taskbar,
chick ‘Show Office Clipboard
lcon on Taskbar’ on the 4
QOptions menu.

3. Enter a theme name in the File name box (Save Current Theme dialog box).
4. Click the Save button to add the saved theme to the Themes gallery.

Copying and Pasting

The next step is to copy the SmartArt graphic from this document window and
then paste it in the newsletter. To copy from one document and paste into another, you
can use the Office Clipboard. Through the Office Clipboard, you can copy multiple
items from any Office document and then paste them into the same or another Office
document by following these general guidelines:

3. Items are copied to a destination document. If the destination document is not
the active document, display the destination document in the document window.

. Paste items from the Office Clipboard to the destination document.

To Copy a SmartArt Graphic Using

1
the Office Clipboard

| 5 FORMAT SECOND PAGE | & ADD PAGE BORDER

"The following step copies the SmartArt graphic to the Office Clipboard. Why# Sometines you want to copy
mltiple itens to the Office Clipboard through the Clipboard task pane and then paste them later.
@ | t1e saved with |
. liob d Dial . - ' new file name
# Click the Clipboard Dialog Box HEp i B0 st ropre
o Copy b
Launcher {(Home tab | Clipboard 'ﬁil it anmncn 2o, A 4 Rivin T
group) to open the Clipboard task
pane.

» |f the Office Clipboard in the
Clipboard task pane is not empty,
click the Clear All button in the
Clipboard task pane.

veiary Dupam Miad furclchecr - Vified S0

Lahbs Bosy c. . p* a" Ax. ¥ B o T - E TR

AsBbCibt  AapbCeDe AaBLTr Azl
g 1y -] ClipboardDialog |. = = == 3. fH- - GMcrmal | SHeSpre.- Hesding i Hes
/ Box Launcher

Chposd . 3 Fuciguip

Clipboard LS

{opagte s Clear 21
i, am tem 1 Paste \ Clear All

| ﬂ:‘.l Ry £TL SEEsEiL button

. 0 4 0 T i i1 g .a

= With the SmartArt graphic

selected in the document window, ] \k =

click the Copy button (Home tab |
Clipboard group) to copy the
selected text to the Clipboard
(Figure 7-67).

Other Ways

SmartArt graphic copied
to OHice Clipboard —
| depending on settings, your

screen may or may not show |

preview of copied graphic

e ———

|

= = R

textbold |

Figure 7-67

1. With Clipboard task pane open, right-click selected item, click Copy

on mini toolbar or shortcut menu

To Switch from One Open
Document to Another

2. With Clipboard task pane open and item to copy selected,
press CTRLHC

{ 23 | LGUD

| 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

The following steps switch from the open Biometrics Diagram Modified document (the source document)
to the open Security Trends Newsletter documnent (the destination document). Why? You want to paste the copied

diagram into the newsletter docinent.
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¢ Point to the Word app button
on the taskbar to display a live
preview of the open documents
or window titles of the open
documents’ depending on your EEEnD Als : pointer positioned
computer’s configuration ; <" on Word app butw\

(Figure 7-68).

five preview

et el 14, Dy i i S o
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@ e Figur —68

* Click the live preview of the Security Trends Newsletter on the Windows taskbar to display the selected document
in the document window (shown in Figure 7-69).

I Other Ways

oy
h‘*:’ 1. Click Switch Windows button (View tab | Window group), dick 2. Press ALT+TAB
document name

i

| |
TO Paste from the Offlce CI | pboa rd 5 FORMAT SECOND PAGE | 6 ADD PAGE BORDER

The following steps paste from the Office Clipboard. Why? You want to paste the copied SmartArt graphic
into the destination dociment, in this case, the newsletter document.

1]

# Position the insertion point at
the end of the first paragraph
at the top of the second
column on the second page of

Aa3bCeD | AaBbCeD AABLE asiato g
ttiosmal | "MoSpac.. Headingd  Heafingz H

Paste |
B ~ Format Psintar

Clprosry Batagrash

e 8

. ’ v - { Clipboard task pane SR | ‘r“- B T T Iy
the newsletter. glrlgl?:ard Clipboard b Close button ek ey e B L g e e
'E'.JEIDL # |f the Cllpboard task - I (n:::lr:::lmov.::’” {Continved-from first-page)§ Seclion Break (Continual
pane 1s not open on E-_.Paste-g 8% petuito it st *Face Recognition-Systemﬁ Many- SmartArt graphic pasted in
the screen, display the | bution newsletter column — your
! play L - To-determine-whether-a-personis: technol graphic may be pasted
Home tab and then click item pasted from alegitimate-vser, -a-face-recogni- files: ar at a different location in

Office Clipboard in

the Clipboard Dialog Box document at location LIRS R (LA LR C L SIS prone.| nevsleter :

of insertion point face-image and:compares-it-with SDmE'finan:ial-set?(s-usewoice- [
D La‘uncher (Home tab | a stored- image.- Some- buildings: verification- Systems.-
Clipboard group} to open the k2 use face: recognition- systems- to- s
C|ipboard task pane. secure-access-to-rooms.-Law-en- ':'._"I o i )
- forcement, surveiliance: systems,- T eV
# Clic e smartArt grapnic and-airports-often-usefacerecog- )
Click the SmartArt graphi f g . .
entry in the Office Clipboard : nition-to-protect-the public. Some- - S 1

mobile-devices use-face-racogni. J

to paste it in the document at _
it

tionsystems-touniock the device. T i
the location of the insertion re—— Face: regom—st——"—=ms. are- w:m K
. . Lo _-“""—\_\_\_'-_""_._, -
point {Figure 7-69). - -
Figure 7-69

@ @

g

A

What if my pasted graphic is in a different location?
g The location of your graphic may differ. You will move the graphic in the rext steps.

Does the destination document have to be a different document?
Mo. The source and destination documents can be the same document.

What is the function of the Paste All button?
If you have multiple iterns on the Office Clipboard, it pastes all itams in a row, without any characters between
them, at the location of the insertion point ar selection,

P 9 @8 9
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o Click the Close button in the Clipboard task pane.

t Other Ways

1. With Clipboard task pane open, right-click selected item, click Paste

on shortcut menu

BTW
ce arou

The space between a
graphic and the text, which
sometimes is called the
run-around, should be at
least 1/8* and should be

the same for all graphics

in a document. Adjust the
run-around of a selected
floating graphic by doing
the following: click the Wrap
Text button (Smartart Tools
Format tab | Arrange group),
chek ‘More Layout Options’
on the Wrap Text menu,
click the Position tab (Layout
dialog box), adjust the values
in the Horizontal and Vertical
boxes, and then click the OK
button.

2. With Clipboard task pane open, press CTRL+V

To Format a Graphic as Floating

The text in the newsletter should wrap tightly around the graphic; that is, the
text should conform to the graphic’s shape. Thus, the next step is to change the graphic
from inline to floating with a wrapping style of tight. The following steps format the
graphic as floating with tight wrapping.

o Click the SmartArt graphic to select it.

e With the SmartArt graphic selected, click the Layout Options button that is attached
to the graphic to display the Layout Options gallery.

e Click Tight in the Layout Options gallery to change the graphic from inline to floating
with tight wrapping.

e Close the Layout Options gallery.

To Format and Position the SmartArt Graphic

The next tasks are to change the color of the graphic, increase its size, and then
position it at the top of the second column on the second page. The following steps
format and then position the graphic.

o With the graphic selected, click the Change Colors button {SmartArt Design tab |
SmartArt Styles group) and then click ‘Colored Fill - Accent 4'.

a Drag the sizing handles outward until the graphic is approximately the same size as
shown in Figure 7-70, which has a height of 3.32" and a width of 4.25". (Verify the
dimensions of the graphic in the Height and Width boxes (SmartArt Tools Format tab |
Size group)).

9 Drag the edge of the graphic to the location shown in Figure 7-70. You may have to
drag the graphic a couple of times to position it similarly to the figure.

6 If the newsletter spills onto a third page, reduce the size of the SmartArt graphic. You
may need to delete an extra paragraph mark at the end of the document, as well.

To LAYER THE SMARTART GRAPHIC IN FRONT OF TEXT

In Word, you can layer objects on top of or behind other objects. If you wanted
to layer the SmartArt graphic on top of all text, you would perform the following steps.

1. Click the SmartArt graphic to select it. Click the Bring Forward arrow (SmartArt
Tools Format tab | Arrange group) to display the Bring Forward menu.

2. Click ‘Bring in Front of Text’ on the Bring Forward menu to position the
selected object on top of all text.
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To Ed It Wra p POI nts in an Object {5 FORMAT SFCOND PAGE | 6 ADD PAGE BORDER

In Word, you can change how text wraps around an object, called editing wrap points. The following steps

edit the wrap points in the SmartArt diagram at the top of the second page of the newsletter. Why? You want to
ensure thut text stavts on a complete line below the botton: of the graphic.

P N | SmartArt Tools r—- .
@ pmagtiny Farmat tab | Wrap Text menu |
diagram . L  Fiaa ]
# If necessary, click the resized, ;
R repositioned,
SmartArt graphic to and selected

select it. Click the
Wrap Text button
{SmartArt Tools
Format tab | Arrange
group) to display
the Wrap Text menu
(Figure 7-70).

Po:il
Test Effect - t

v . ] ER '.
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) | group
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Figure 7-70

@ | graphic _
e e et surroundid with e r———
# Click ‘Edit Wrap K y . T k=) wap polnts A B
Points’ on the Wrap prtinued from first page)fl—seasn s tceaumons) ooy /\ )
Text menu to display e Recognition- System™) . TR ' | government. security. organiza-
wrap points around determine-whether-a-person. »-=me il tions,-and. the. military.- Some
the graphic. a: legitimate. user,- a- face- =0 ) .

# Position the pointer
on the black wrap
point to the lower-
left of the shape
in the diagram
containing the text,
voice pattern, as
shown in Figure 7--71,

i bile-devices-i pointer shape  vaio patt i . .
so that the pc;lnter nsystemsto chavged when | | ey verify. an- identity.- For. example,-
:lhar;ggsc;ma o ce- recognitio &32'332?33" files. 1t~.“:“- 7 and: i some grocery stores, retall stores,
eaded dot. To- 8. i ) and- gas- stations use. biometric-
coming.__maes networks.-To-secyre phone-bank gas=siatlol
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| backofiheretina.q]

ognition- system. captures. 8 ‘“ ¢
eirlive-face image-and-com- i
res. it- with- a- stored. image.. =
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- systems-to- secure-access. . .f}( ;
rooms.- Law- enforcement, |/
eillance-systems,-and-air- |
s-often-use-face-recogni- "\
to-protect-the.public. Some.

h‘,\ organizations. use. retinal. [

'_""-r‘:.iﬂmET.riL-Dex-irr-:l]

| Biometricdevices-are gaining:
/& popularity-as.a-security-pre-

_f cavtion. because- they- are. a
virtually foolproof. method. to-

S B e
Figure 7-71
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3

# Drag the black wrap point to the
lower-left of the graphic as shown
in Figure 7-72, so that the text
{the word, files, in this case) will
appear on a complete line below
the shape.

4]

# Drag the black wrap point to
the lower-right of the graphic as
shown in Figure 7-73, so that the
text begins on a complete line
below the graphic.

# Click outside the graphic so that it
no longer is selected.
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Figure 7-72
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Figure 7-73

Finishing the Newsletter

With the text and graphics in the newsletter entered and formatted, the next step is to
view the newsletter as a whole and determine if it looks finished in its current state. To
give the newsletter a finished appearance, you will add a border to its edges.

To Adjust Headings, Turn Off Formatting Marks, and Zoom

Multiple Pages

Instead of printing and
distributing a hard copy of a
document, you can distribute
the document electronically.
Options include sending the
document via email; posting
it on cloud storage (such as
OneDrive) and sharing the
file with others; posting it

on social media, a blog, or
other website; and sharing a
link associated with an online
location of the document.
You also can create and share
a PDF or XPS image of the
document, so that users can
view the file in Adobe Reader
or XPS Viewer instead of in
word

The last step in formatting the newsletter is to place a border around its edges.
First, you remove a hyphen from a heading by adding a line break. Then, you turn off
formatting marks to remove the clutter from the screen, and you place both pages in
the document window at once so that you can see all the page borders applied. The
following steps add a line break, turn off formatting marks, and zoom multiple pages.

o If necessary, scroll below the SmartArt graphic to display the Signature Verification
System heading. To remove the hyphen in the word, System, piace the insertion point
to the left of the § and then press SHIFT+ENTER to create a line break and move the
entire word, Systermn, to the next line (shown in Figure 7-74}.

e If necessary, display the Home tab and then turn off formatting marks.

9 Display the View tab and then display multiple pages on the screen. You may need to
increase the zoom slightly so that the borders in the nameplates appear.
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To Add an Art Page Border

o |

| 6 ADD PAGE DoEDER

The following steps add a page border around the pages of the newsletter. Why? This newsletter bas a teal

art border around the perimeter of each page.

@

e Display the Design tab.

o Click the ‘Borders and Shading’ button (Design tab | Page Background group) to display the Borders and Shading
dialog box. If necessary, click the Page Border tab.

« | What if | cannot
select the ‘Borders
and Shading’

button because it is
dimmed?

Click somewhere in
the newsletter to
make the newsletter
the active document
and then repeat
Step 1.

12

¢ Click Box in the
Setting area (Borders
and Shading dialog
box) to specify a
border on all four
sides of the page.

Q&

# Click the Art arrow,
scroll to and then
click the art border
shown in
Figure 7-74.

Borders and
Shading diatog box |

Design tab

Box selected pocders  PageBorder  §mading

both pages
are displayed

\ *“'Wi [ A

Preview

ik oo diageam below or
wse buttans 14 apply barders

L.

Applyto
wWhate dotument

Figure 7-74

'Borders and
Shading’ button

q

ermark  Page
. olor

5
L]
Pagt

Barders

Page

group

e
' Page Packground f

Background

i

+ Click the Color arrow and then click ‘Teal, Accent 5, Darker 50%’ (bottom row, ninth column} on the palette (Figure 7-74),

(3

# Click the OK button
to place the defined
border on each page
of the newsletter
{Figure 7-75).

art border
added |

® @ B

Figure 7-75
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BTW
Conserving Ink

and Toner

If you want to conserve ink
or toner, you can instruct
Word to print draft quality
documents by clicking File
on the ribbon to open the
Backstage view, clicking the
Options tab in the Backstage
view to display the Word
Options dialog box, clicking
Advanced in the left pane
(Word Options dialog box),
scrolling to the Print area

in the right pane, placing a
check mark in the ‘Use draft
quality' check box, and then
clicking the OK button. Then,
use the Backstage view to
print the document as usual.

CONSIDER THIS: PLAN AHEAD %

To Save, Print, and Exit Word

The newsletter now is complete. You should save the document, print it, and
then exit Word.

@ Save the newsletter again on the same storage location with the same file name.

@ If desired, print the newsletter (shown in Figure 7-1 at the beginning of this module).

< |What if an error message appears about margins?

g Bepending on the printer you are using, you may need to set the margins differently
for this project.

What if one or more of the borders do not print?

Click the 'Borders and Shading’ button (Design tab | Page Background group), click the
Options button (Borders and Shading dialog box}, click the Measure from arrow and
click Text, change the four text boxes to 15 pt, and then click the OK button in each
dialog box. Try printing the document again. if the borders still do not print, adjust
the text boxes in the dialog box to a number smaller than 15 pt.

@ Exit Word, closing ail open documents.

Summary

In this module, you have learned how to create a professional-looking newsletter using
Word’s desktop publishing features such as the following: inserting and modifying
WordArt, organizing a document in columns, adding horizontal and vertical rules,

inserting and formatting pull-quotes, inserting and formatting graphics, and adding an
art page border.

What decisions will you need to make when creating your next newsletter?
Use these guidelines as you complete the assignments in this module and create your own newsletters outside of this class.

1. Create the nameplate.

a) Determine the location of the nameplate.
b) Determine content, formats, and arrangement of text and graphics.
Q) if appropriate, use ruling lines.
2. Determine content for the body of the newstetter,
a) Write the body copy.
b) Organize the body copy in celumns,
¢) Format the body copy and subheads.
d) Incorporate color.

e} Divide sections with vertical rules.
f) Enhance with visuals.
3. Bind and distribute the newsletter.

a) Determine if newsletters should be printed, posted on bulletin boards, sent as an email message, or posted on

websites,

b) For multipage newsletters that will be printed, determine the appropriate method of binding the pages.

c} For online newsletters, select a format that most users will be able to open.
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Apply Your Knowledge

Reinforce the skills and apply the concepts you learned in this module.

Working with Desktop Publishing Elements of a Newsletter
Note: To complete this assignment, you will be required to use the Data Files. Please contact your
instructor for information about accessing the Data Files.

Instructions:  Run Word. Open the document named Apply 7-1 Energy Saver Newsletter Draft
from the Data Files. The document contains a newsletter that you are to modify so that it appears as
shown in Figure 7-76.

Perform the following tasks:
Change the WordArt shape to Chevron Down.

[y

2. ‘Turn on automatic hyphenation.

3. Change the column width of the columns in the body of the newsletter to 1.9".
4. Add a vertical rule (line) between each column.
5

. Change the style of the pull-quote (text box) to ‘Light 1 Outline, Colored Fill - Dark Green,
Accent 3’ (Drawing Tools Format tab | Shape Styles group).

6. Format the first paragraph with a drop cap.

7. Change the alignment of the paragraph containing the drop cap from left-aligned to justified.
8. Change the layout of the SmartArt graphic to Converging Radial.
9

. Use the Text Pane to add the text, Building Automation, to the empty shape in the SmartArt graphic.
Verify that the font size of text in the top and bottom shapes is 14 point and 11 point, respectively.

10. If necessary, move the SmartArt graphic and the pull-quote so that they are positioned similarly
to the ones in Figure 7-76.

11. Change the color of the page border to Orange, Accent 5, Lighter 40%.

12. If requested by your instructor, add your naine to the left of the text, Weekly Newsletter, in the
issue information line. : — —

ip Sved Prewrietier Kicddad doue - Word
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pages, reduce the size of elements ) change
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this equations

Extend Your Knowledge

Extend the skills you learned in this module and experiment with new skills. You may

need to use Help to complete the assignment.

Adding Equations to a Newsletter and Enhancing a Nameplate

Note:  To complete this assignment, you will be required to use the Data Files. Please contact your
instructor for information about accessing the Data Files.

Tustructions:

Run Word. Open the document, Extend 7-1 Frosh Tips Newsletter Draft, from the

Data Files, You will add equations to the newsletter, change the forinat of the WordArt, format
the drop cap, adjust the hyphenation rules, move the page border closer to the text, clear tabs, and

insert leader characters.

Perform the following tasks:
1. Use Help to learn about equations, WordArt options, borders, hyphenation, and tabs.

2. Insert the equations shown in Figure 777 in the newsletter in their appropriate locations. Hint:
Use the ‘Insert an Equation’ arrow or ‘Insert an Equation’ button (Insert tab | Symbols group).

3. Change the WordArt by adding at least two WordAut style text effects. Change the color of the
WordArt text outline. Change the color of the WordArt text fill color.

4. Add a shape fill color to the text box surrounding the WordArt.

5. Add a drop cap to the first paragraph in the body of the newsletter. Change the number
of lines to drop from three to four lines. Change the distance from the text to 0.1,

©On Friday, August 19, join one
of the guided tours of your
new campus. Each classroom
building will bs wisited, and
adr change hyphenation ¢ Will

rules n see
where your classes are while
at the same time meeting
other incoming frashmen. You
alse will learn how to use the
campus app!

Study Groups

you wani

information, conta
Affairs at extension 4132

Events

Each month, many programs
and lectures are offered. Last
year, events such as Student

| Musicians, Networking, and
: Exploring Spaca were among
the more popular offerings.

To find out about npcoming
events, use the campus app or
visit Student Affairs,

i

move border

closer to text

for Math

Check out this month's list of
quick reference equations
you can use in your Algebra
and Trigonometry classes!

To add fractions:

a+c_ad+bc
b d " bd

To multply fractions:

a ¢ _ac

%37 bd

To use the distributive law:
[T {b = ¢} = ab + ar

W:uea of a circle-

A = e

d the area of a triangle:
1

A= 3 bh
ToYind the surface area ofa
sphe
3p)

§ =4t
T the volume of a

L

'o ind
herg:
By =§ma N

——

Figure 7-77

6. Change the hyphenadon rules to limit

10.

11.

consecutive hyphens to two.

. Change the page border so that the

border is closer to the text.

. If the newsletter flows to two pages,

reduce the size of elements, such as
WordArt or the pull-quote or the

table, or adjust spacing above or below
paragraphs so that the newsletter

fits on a single page. Make any other
necessary adjusunents to the newsletter.

. Clear the tabs in the issue

information line in the nameplate.
Use the Tabs dialog box to insert

a right-aligned tab stop at the 7"
mark. Fill the tab space with a leader
character of your choice.

If requested by your instructor, change
the word, Freshman, in the issue
information line to your last name.

Submit the revised newsletter in the
format specified by your instructor.

. €3 Which equations are predefined

in Word? Which structures are
available on the Equation Tools
Design tab? How do you change the
alignment of an equation?

sy m
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Expand Your World

Create a solution that uses cloud or web technologies by learning and investigating on
your own from general guidance.

Using Windows Essentials
Instructions:  You have heard that Windows Essentials includes some useful programs, so you
decide to learn about it, download it, and use its programs.

Note:  You may be required to use your Microsoft account to complete this assignment. If you
do not have a Microsoft account and do not want to create one, read the assignment without
performing the instructions.

WA 4 ]

Perform the following tasks: i : iy T P
. . Windows & o i ‘Devices ' " Apps+game:

1. Run a browser. Search for the text, Windows e A P A S B LA
Essentials, using a search engine. Click a link to : e

learn about Windows Essentials. —

2. Navigate to the website to download Windows

Essentials (Figure 7-78) and then follow the Wi nd OwWS Esse ntia I S

instructions to download Windows Essentials.
. . Do more with free programs from Windows.
3. One at a time, run each program included

with Windows Essentials. Browse through the | m
features and functions of each program. I
ar download options
4. €3 What programs are included with Windows View systemm racuiramants B
Essentials? What is the purpose of each program? Y i S MU S X
Which programs will you use and why? Figure 7-78
In the Labs

Design, create, modify, and/or use a document following the guidelines, concepts, and
skills presented in this module. Labs 1 and 2, which increase in difficulty, require you to
create solutions based on what you learned in the module; Lab 3 requires you to apply your
creative thinking and problem-solving skills to design and implement a solution.

Lab 1: Creating a Newsletter with a Pull-Quote
(Text Box) and an Article on File

Note:  To complete this assignment, you will be required to use the Data Files. Please contact your
instructor for information about accessing the Data Files.

Problern:  You are an editor of the newsletter, Vintage Living. The next edition is due out in one
week (Figure 7-79). The text for the articles in the newsletter is in a file on the Data Files. You need
to create the nameplate and the text box for the pull-quote.

Perform the following tasks:
1. Change all margins to .75 inches. Depending on your printer, you may need different margin
settings. Change the theme to Retrospect.
2. Create the nameplate using the formats identified in Figure 7-79. Create the title using WordArt.
Set the WordArt wrapping to “Top and Bottom”. If necessary, drag the bottom of the WordArt up
to shorten the image. Dimensions of WordArt should be approximately 1.41" x 7.06". Set a right-
aligned custom tab stop at the right margin. Continned

Word Module 7
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In the Labs contined

3. Below the nameplate, enter the heading, Purchasing an Old House: Part 1, as shown in the

figure. Format the heading using the Heading 1 style. Change the spacing above this paragraph
to 24 pt and the spacing after to 12 pt.

4, Create a continuous section break below the heading, Purchasing an Old House: Part 1.
S. Format section 2 to three columns.

6. Insert the Lab 7-1 Purchasing an Old House - Part 1 Article file, which is located on the Data
Files, in section 2 below the nameplate.
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WordArt:

style - Filk - Tan, Accent 1, Outline -
Background 1, Hard Shadow - Accent 1;
font — 72-point bold Harrington

text outline - Orange, Accent 1

text fill - gradient preset - Radial
Gradient - Accent 1; second and fourth
stap color — Tan, Accent 5, Darker 50%;
direction - From Center

text effect shape (transform) - square

7. Format the newsletter according to Figure 7—-79. Insert a column break
before the heading, Brick and Stone. Columns should have a width of 2.1"
with spacing of 0.35". Place a vertical rule between the columns.

" e

8. If necessary, insert a continuous section break at the end of the document to
balance the columns.

&
o

\

\

EEie e

\?intaggz lsiving

Weekly Newsletter

Issue 36

Puschasing an Old House: Part 1

hen purchasing an old
Whouse with the intent
of saving money, you
m?(‘ be aware of several

pe | hidden costs. Many

Tan, Accent 5,
arker 50% P

unchecked, can lead
d costs after

vou Fave tlosed a sale. Once you
have located a potential house for
purchase, therefore, you should
inspect {or hire a professional to

If the paint is older than seven
years, peeling Is natural. When a
house is insulated poarly, heat
pes and moisture develop
The moisture saturates the wood
while trying to escape. In these
cases, the house has to be
reinsulated by removing the
outside or inside walls to make
the paint stick.

Brick and Stone
If the house has brick
ifit is a solid brick
brick. Solid brick

31-point Qrange,
Accent 1, Darker
50% double
bottom border

have a header brace every third or
fourth row with full bricks in the
wall. A header brace is full bricks
laid the opposite direction.
Veneer brick, the most common
today, is an outside layer of brick

9. Format the subheads using the Heading 2 style.

10. Insert a text box using the

Retrospect Quote built-in text
box. The text for the pull-quote
is in the Paint section of the
article. Split the window. Use
the split window to copy the
text and then paste it in the text
box. Remove the split window.
Change the fill color (shape fill)
of the text box to Brown, Accent
4. Change the font to 12-point
Bookman Old Style. Resize the
text box so that it is similar in
size to Figure 7-79. Position
the text box as shown in

Figure 7-79.

) Checking Is when the paint hes | 2%26hed to an exsting studded 11. Add the page border as shown
inspect] all areas of the home. wall, giving the appearance of an
little cracks on its surface with a ‘e o h f
N . M all-brick home. Although veneer in the ngure.
Part 1 of the Purchasing an Old rough-looking finish. Checking is T V.
House article in this issue of | caused by insufficlent deying time i ﬁ 12. 1f the document does not fit
Vintoge  Living between coats or poor- .;dm - termites. and N ; . . B
discusses some quality paint. To correct |+ h‘”::' » and poa on a single page, adjust spacing
i N
checks for the a checking problem,
above and below paragraphs.
exterior, Three you have to remove the Stone houses are a lot like veneer p g p
common home paint hY. “':'PP'"B or brick houses in their construction 1 3 , If requested by Your instructor,
de sandblasting it and then and potential problems. The
pull-quote po P! .
nd repaint. major difference is stone houses change the word, Weekly, in
tone, : a g 5 .
stone Chalking Is when the ::“ '““;h mare. "‘p’::‘d“ the issue information line to
B paint surface is dull and use of construction methods, our name
IF the house is powdery. It is caused | eyt |soue— Part 2 b ’
painted, look for from the use of oil- Next Ws issue, which is th . N
. b, | bt . Tocats kg, | e e o 14 Save the document with Lab 7-1
simply wash the wall surface, Be items to ook for when purchasing [ Vintage lemg Newsletter as
Peeling is when the paint has aware, though, thateach time the W b th 31-point .
lted from the wall ke oange | surface is washed, the paint | o oo oo Covers these areas | Orange, the file name and then submit
peels). Peeling usually is caused becomes thinner. i ' art page. 11 1
D i et o oo meaion, space, and roof. il itin the format specified by
y0ur instructor.

Figure 7-79

15.

€2 This newsletter used a pull-
quote. What other text in the
newsletter could appear in the
pull-quote?
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Lab 2: Creating a Newsletter with a SmartArt Graphic
and an Article on File

Note: To complete this assignment, you will be required to use the Data Files. Please contact your
instructor for information about accessing the Data Files.

Problem:  You are responsible for the monthly preparation of the newsletter called Health Check.
The next edition discusses technology-related repetitive strain injuries (Figure 7-80). This article
already has been prepared and is on the Data Files. You need to create the nameplate, the SmartArt
graphic, and the section at the bottom of the newsletter.

Perform the following tasks:

1. Change all margins to .75 inches. Depending on your printer, you may need different margin
settings. Change the document theme to Droplet.

2. Create the nameplate using
the formats identified in
Figure 7-80. Create the
title using WordArt. Set a
right-aligned custom tab
stop at the right margin.
Set the WordArt wrapping
to Top and Bottom, If
necessary, drag the bottom
of the Word Art up to
shorten the image. Search
for and insert an image of a
check mark, similar to the
one shown in the figure
(the exact image is located
on the Data Files). Resize
and rotate the image
as shown in the figure.
Format the image as
Behind Text and position
the image as shown.

3. Below the nameplate,
enter the heading,
Technology-Related
Repetidve Strain Injuries,
as shown in the figure.

4. Create a continuous
section break below the
heading.

5. Format section 2 to two
columns.

6. Insert the Lab 7-2
Health Risks for
Technology Users Article
file, which is located on
the Data Files, in section
2 below the nameplate.

—

WordArt:

10-point, Lime,
Accent 3, Darker

* style - Fill - Lime, Accent 3, Sharp Bevel

» font - 72-point beld Anal Rounded MT Bold;
¢ text outline weight - 1 pt

* shape - Curve Down

Monthly Newslelter

=

he widespread vie of technology ond related devices

Heading 1 t led to importaat user heolth concems, For exomple,
style, 12 point elonged or improper computer ond mobile device
ab“”e and6 | conkadto injaries or disorders of the honds, wrists,
point below

paragraph

d elbows. You sheuld be proactive ond minimize your
ance of lechnology-related risk.

[w

| Heading 2 style

Repetitive Strain Injurics
A repelitive strain injury {RS) is an injury or disorder of
/'s the muvscles, ne rves, tendons, ligaments, and joints. RSls

di T ; oted to the use of tedinalogy inchide tendonitis and
eading 2 styfe pal tuanel syadrome.

*  Tendonitis is mflommation of a tendon due to
repeated mofion or sfress on thot lemdon.

* Carpal wnpel syndrome {CT$) is inflommation
of the nerve that connects the foream to the

:

o

: : palm of the wrist.

: Repeated or forcehul beading of the wrist can cavse
iy tendonitis of the wrist or CTS. Sympioms of tendenitis

5 of the wrist nclude extreme pain that extends from

[ the forearm lo the hand, along with tingling & the fin-

; gers. Symploms of CTS incude buming poln when the
: neve is compressed, along with numbness and fingling
& in the thumb ond first two fingers.

! Long-tem cemputer werk ean lead te tendonitis or CT5.
Foctors that cavse these disorders mclude prolonged
typing sesions, prolonged mouse vinge, or continyal
shifting between a mouse and keyboard. IF untre ated,
it is possible for these disorders to lkead to permanent
physical domage.

Technoloegy-Related Repetitive Strain Injuries

50% art border 7]
rotated graphic .

| Heading 3 style |

Prevenling Technology-Reloted Tendonitis ec T Va-point
Follow these precautions to help prevent tendenitn or' dotted

CTS related to technology vse line, Blue,
Accent 1,
*  Take frequent brecks to exercise your hemds, Da:ker

and ams. 50%

* Do not rest your writh on the edge of o detk.— —
Instead, ploce a wrist rest between the edge of
your desk ond the keyboard.

»  Ploce the mouse ol least six inches from the
edge of the desk. In this position, your writt is
flat on the desk.

e Minimize the frequency with which you switch
between using the mouse ond the keyboord.

+  Keep your foreams and wrists level so that
your wrisls do not bend.

+  Avoid using the heel of your hond as o piver

. point while typing or vsing the mouse,
3 s Keep your shaylders,

ESpcedfum ormy, honds, and wrists

[y e e e Ry S T R T P |

! apon for wveral relaxed while you work.
wrionds whic L
kaoping wrkh s Be wre to maintain
thraight, roper po’
SmartArt graphic
¢ SI0P Lermiigorrgp e i
Gontly puth bock experience  foligue or
fingmes and then h
thoob, pain.
¢ Seek advie from a
healih prefessionol if you
Dangle e nofice the onset of symp-
':n:"z.:':d: toms of tendonitis or CTS.
armi ond honds.

Upzeming Health Fairs

Strong style for
bulleted items

o Friday, Octobar 6, from 9:00 a.m. to 5:00 p.m. ot the VFW on Wicker Park Boulevard in Dilton. 14-point dot‘;ed ling,
* Saturday, Oclober 7, from 10:00 a.m. 4o 4:00 p.m. ot Rosewood Community Carder in Horrust. Blue, Accent 1,
s Tusiday, October 10, from 8:00 a.m. to 1:00 pom. at the public library in Tipon

" Darker 50%
e

Figure 7-80

Continned >
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WD 432 Word Module 7 Creating a Newsletter with a Pull-Quote and Graphics

in the Labs contintied

7. Format the newsletter according to Figure 7 -80. Columns should have a width of 3.33" with
spacing of 0.35". Place a vertical rule between the columns.

8. Use Word’s automatic hyphenation feature to hyphenate the document.

9, Insert a continuous section break at the end of the last bulleted item in the second column to
balance the columns.

10. In the next section, change the number of columns from two to one. Enter the text shown at
the bottom of the newsletter.

11. Add the page border as shown in the figure.

12. Open a new document window and create the SmartArt graphic shown in Figure 7-80. Use the
Stacked List layout. Because this newsletter has only one list, delete the shapes for the second list.
Add the text shown in the figure (you will need to add shapes to this list). Resize the border of
the SmartArt graphic to the edges of the list shapes. Use the Office Clipboard to copy and paste
the SmartArt graphic from the current window to the newsletter. Change the wrapping to tight.
Resize the pasted graphic as shown in the figure. Change the colors to Colorful Range - Accent
Colors 3 to 4. Edit wrap points as necessary so that the text wrapping is similar to the figure. Note
that your graphic may look slightly different from the figure due to variations in the shape size.

13. If the document does not fit on a single page, adjust spacing above and below paragraphs.

14. If requested by your instructor, change the community center name from Rosewood to your
last name.

15. Save the newsletter using Lab 7-2 Health Check Newsletter as the file name and submit it in
the format specified by your instructor.

16. €7 How many sections are in this newsletter? How many columns are in each section? If you
wanted to add a second page to this newsletter, what type of section break would appear at the
end of the first page?

Lalb 3: Consider This: Your Turn

Create a Newsietter about ATM Safety

Note:  To complete this assignment, you will be required to use the Data Files. Please contact your
instructor for information about accessing the Data Files.

Problem:  As a part-time employee at a local bank, you have been assigned the task of creating a
newsletter called Bank News, which will be available to all patrons. The article in Issue 28 of the
Bank News newsletter covers AT'M safety. The text for the article is in a file called Lab 7-3 ATM
Safety Article on the Data Files.

Part 1: The newsletter should contain at least two of these graphical elements: an image, a
SmartArt graphic, a pull-quote, or a table. Enhance the newsletter with a drop cap, WordArrt, color,
ruling lines, and a page border. Be sure to use appropriate desktop publishing elements, including a
nameplate, columns of text, balanced columns, and a variety of font sizes, font colors, and shading.
Use the concepts and techniques presented in this module to create and format the newsletter.

Be sure to check spelling and grammar of the finished newsletter, Submit your assignment in the
format specified by your instructor.

Part 22 €73 You made several decisions while creating the newsletter in this assignment: how to
organize and format the nameplate (location, content, formats, arrangement of text and graphics,
ruling lines, etc.), which two graphics to use (image, SmartArt graphic, text box, or table), and how
to organize and format the body copy (columns, formats, headings and subheads, color, vertical
rules, etc.}. What was the rationale behind each of these decisions? When you proofread the
document, what further revisions did you make and why?




